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All rights reserved

This manual, as well as the software described in it, is furnished under license andmay be used or copied only
in accordance with the terms of such license. The content of this manual is furnished for informational use
only, is subject to change without notice and should not be construed as a commitment by TechSmith Cor-
poration. TechSmith Corporation assumes no responsibility or liability for any errors or inaccuracies that may
appear in this manual.

Trademarks
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registeredmarks or marks of TechSmith Corporation in the U.S. and/or other countries. This list is not a com-
prehensive list of all TechSmith Corporationmarks. The absence of a name/mark or logo in this notice does
not constitute a waiver of any intellectual property rights that TechSmith Corporation has established in any of
its product, feature or service names/marks or logos. All other marks are the property of their respective own-
ers.
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Introduction
This document introduces you to TechSmith Relay, walks you through configuring the system, and provides
you with administration information to help you to keep TechSmith Relay running smoothly.

TechSmith Relay Administration Help Topics

Important TechSmith Relay Concepts

Configuration of TechSmith Relay

TechSmith Relay Administration Reference

Need More Help

Working with Technical Support
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TechSmith Relay Overview
With TechSmith Relay, you can capture and publish your lecture or presentation anytime, anywhere -- in the
classroom, in the conference room, at your desk, or at home. TechSmith Relay supports video and image file
formats, allowing any lecture or presentation to be viewed by your audience onmultiple playback devices
includingmobile devices.

There are two parts to TechSmith Relay—the recorder, which runs on a presenter’s computer, and the server
which processes and publishes all presentations.
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Important TechSmith Relay Concepts
Before you configure TechSmith Relay, there are several concepts you should be familiar with. Please review
the following topics. You can find additional information in the TechSmith Relay Administration Reference
part of this help.

Profiles
Profiles are the backbone of TechSmith Relay. They allow presenters to record or uploadmedia without hav-
ing tomake any decisions about how the content is processed or where it is placed for viewing.

Profiles are created by the administrator and include settings that define how the content is captured, pro-
cessed, and published. Careful consideration of how you want to set up your organization’s profiles helps sim-
plify maintenance of the profiles over time.

Things to consider:

Youmay want to first create a test profile to make sure that you understand the parts of the profile and
some of the options available to ease day to day maintenance, such as variables.
The profile title is the only thing presenters can see in the TechSmith Relay Recorder. The profile
description is only visible on the website. Consider carefully how you choose profile titles so that they
convey their intended use to presenters.

Good title examples:BIO-101, Sales Dept Meetings, Weekly Status Reports, Personal
Recordings
Poor title examples:MP4Output, Presenter, 10142

TheUpload and Decide Later Profile uploads media to the TechSmith Relay server, but does not
process it. The uploaded content stays in theNeeds Attention state on the server until an admin-
istrator or the presenter selects a profile to use or deletes it.

For more information, seeProfiles

Variables
Variables can help simplify themanagement of profiles, publish destinations, publish accounts, and noti-
fications. These “placeholders” have a value applied to them at the time a presentation processes.

There are administrator-defined and system-defined variables available:

Administrator-defined variables

Create a variable, use the variable in multiple places, andmanage the value in central location.

For example, you can create a global variable for Semester, add it to a file system publish destination
path and use the publish destination for multiple profiles. When the semester is over, you change the
value once, and the publish destinations paths are automatically adjusted to reflect the change.

System-defined variables

These variables are included in the TechSmith Relay system and change based on the information for
the presentation that is being processed.

For example, you can use the system variable for the presenter’s username in a publish destination file
path such as \\media.company.com\presentations\{s:PresenterUserName}. When the
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presentation is published, the presenter’s username is substituted in the file path and places the
presentation in that presenter’s network folder.

For more information, seeVariables.

Administrators Cannot Record Presentations
Administrators cannot make recordings or log in to the TechSmith Relay Recorder.

To record or uploadmedia using the TechSmith Relay Recorder, youmust create a presenter account. The
presenter account cannot have the same email address as the administrator account.

If you are using LDAP, instead of creating a new user in LDAP, create a new user on the TechSmith Relay
website. SeeManually Add Users to TechSmith Relay for more information about how to create a new
user.

TechSmith Relay Recorder
There are a few ways to access the recorder:

Administrators and presenters can download the TechSmith Relay Recorder from the TechSmith
Relay website.
Administrators can also obtain the files at:

{base URL}/Relay/Downloads/WinTechSmithRelay.exe (Windows)

{base URL}/Relay/Downloads/MacTechSmithRelay.zip (Mac)

{base URL}/Relay/Downloads/PortableTechSmithRelay.zip (Portable)

The server URL is hard coded into the recorder. If you havemultiple instances of
TechSmith Relay in your organization and are distributing the files to presenters make
sure presenters are installing recorders from the correct server instances.

In a locked-down or controlled environment, the administrator can choose to deploy the TechSmith
Relay Recorder forWindows operating systems instead of having the users download it from the
TechSmith Relay website.
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Configuration of TechSmith Relay

Before starting configuration, please review Important TechSmith Relay Concepts.

After installation, you need to configure TechSmith Relay beforemaking it available to presenters. Use the fol-
lowing processes to configure your server properly.

1. Define Publish Destinations

2. Set Up Notifications

3. Create Profiles

4. Add Users to TechSmith Relay

Other things to do before you start using TechSmith Relay

Activate / Deactivate TechSmith Relay Server

Roll-Out TechSmith Relay

Deploy TechSmith Relay Recorder

1. Define Publish Destinations
Publish Destinations are the locations that presentations are placed when processing is complete.

TechSmith Relay can publish presentations tomany kinds of media servers. For more information on setting
up a specific type of publish destination, seePublish Destination Setup.

Completed presentations should not be published (hosted) on the TechSmith Relay server.

To Create a Publish Destination

1. Go to Profiles > Publish Destination Setup.
2. Click one of the publish destination types to create a new destination.



www.techsmith.com - 6 -

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. See
Plug-Ins for more information.

3. Enter all required information. In many cases, you can use variables to help createmulti-purpose pub-
lish destination paths and URLs.

4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

Publish Account Setup
After you create a publish destination, you define the account for TechSmith Relay to use to access it.

Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

To Create a Publish Account

1. On the Publish Account page (Profiles > Publish Accounts Setup), click one of the publish des-
tinations you have set up.

2. Enter information for the new account.
3. Select if you want to make the account the default account. See the tips below for information about

default accounts.
4. If not a default account, select if you want toUse account information from default account. This

allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

5. Click Save.

Things to Consider About Publish Accounts

The following informationmight help you inmaking some decisions when creating your publish accounts.
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You can let presenters enter their own information.

If you would like to use this option, you do not have to set up a publish account. Instead, you will select
toUse presenter accountwhen configuring a profile.

Each publish destination can have a default account.

This can be helpful in several ways:

You can set up a default account to hold the credentials used to access a publish destination,
and then use the other accounts to place presentations into various folders.
When you select a publish destination and encode setting in a profile, the default account is
selected automatically for the publish account.
If the default account for a publish destinationmay change from time to time, you can select
Use default accountwhen configuring a profile. You can then change which account is the
default account without having to change anything in the affected profiles. The profiles use the
currently selected default account for a given publish destination.

You can select different publish accounts for each publish destination/encode setting combination in a
profile.

2. Set Up Notifications
Notifications are the various ways that people are informed when presentations are published. They are sent
per profile and can include information about multiple processed presentations.

To set up notifications, you first configure the notification server and then create custom notifications. If you
want to use the email server you set up during installation, you can skip ahead toNotification Setup.

You can configure three types of notification servers:

BlackBoard:Posts notifications directly to BlackBoard

Email:Sends notifications through the email server.

You can only configure one email server.

Moodle:Posts notifications toMoodle.

For more information on setting up a specific type of notification server, seeNotification Server Setup.

Configure a Notification Server

1. Go toProfiles > Notification Server Setup.
2. Click one of the server types to create a new notification server.
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If the notification server type you would like to use is not available in the list of noti-
fication servers, youmay have to install the appropriate plug-in before you can use it.
SeePlug-Ins for more information.

3. Enter all required information.
4. Click Save.
5. The notification server information is saved and you are presented with a link to theNotification Setup

for this server.
6. Click the link to continue withNotification Setup.

Notification Setup
After you configure a notification server, you create notifications to use with that server.

You can select who receives notification and what kind of information they receive about published present-
ations.

Create a Notification

1. On the Notification Setup page (Profiles > Notification Setup), click one of the notification servers.
2. Enter information for the notification. Depending on which server type you select, you will enter dif-

ferent types of information.

You can use variables to allow one notification to be used inmultiple cases. For more information, see
Variables.

3. Select aDetails Template to use.

Click Samples to preview what information each template includes.

This template defines what information to include in the notification. A notification contains information
for each encoding you select to include in this notification in the profile.

ChooseMessage only if you only want to specify amessage and not include additional details.

4. Enter amessage to include in the notification. This can be a personalized greeting, additional present-
ation information, or left blank. You can use variables in this field.

5. Click Save.
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Things to Consider About Notifications

The following informationmight help you inmaking some decisions when creating notifications.

When you set up a profile, you can choose which encodings you want to include in each notification.

For example, you could create a profile that contains both aWeb video and a TREC file. You can
include theWeb video information in a notification that goes straight to viewers and include information
on the TREC file in a notification that goes only to the presenter.

You can preview the information included in each of the details templates by clicking the Samples link.
For more information on the details templates, seeDetails Templates.
You can use variables to allow for a single notification to be used for multiple uses.

For example, use the system variable {s:PresenterEmailAddress} in the To field of an email
notification. Any profile that uses that notification always sends an email to the email address of the
presenter associated with the presentation.

If you use variables in themessage of a notification, some variables only receive information from the
last processed encoding in a presentation.

For example, if you use the system variable {s:PublishFilePath} in themessage of a notification
and havemultiple encodings set up in the selected profile, only the file path of last published encoding
is included in themessage.

TechSmith Relay does not send separate notifications for each encoding selected in a profile, but
instead rolls information for each encoding into a single notification.

For example, if in a profile you select to include three encoding types in a notification, the recipient
receives one notification including information about all three encodings rather than three separate noti-
fications.

3. Create Profiles
After you have defined the publish destination and set up notifications, you are ready to create profiles.

To start creating a new profile:

1. Go toProfiles.
2. Click theNew Profile button.

The Profile Setup page opens.

3. Work through, from top to bottom, the tabs at the left side of the page.

These tabs are:

Profile Settings

Publish Destinations

Encode Settings
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Publish Accounts

Notification Selection

Notification Assignment

Variable Definition

Associated Users

Overview

Profile Test

Tab Status Icons

As you are working through the tabs, each tab shows its current status. The status icons are as follows:

Everything on this tab is valid and in working order.

Something on this tab is not quite right. Youmight want to verify that you are not missing
anything. This does not make a profile invalid.

Example: There are no notifications selected.

There is an error on this tab. You will need to enter or correct information before this profile
can be used.

Example: There are publish destinations without encode settings selected.

Define Profiles Settings
In the Profile Settings tab of the Profile Setup, enter basic information about the profile.

1. Enter a title for the profile.

Remember that the profile title is the only thing presenters can see in the recorder. The profile descrip-
tion is only visible on the website. Consider carefully how you choose profile titles so that they convey
their intended use to presenters.

2. Enter a description.
3. Select the Transcription Settings.
4. Click Save.
5. Click thePublish Destination tab to continue.

Select Publish Destinations
In the Publish Destinations tab, you select the publish destinations you want to use for presentations pro-
cessed with the profile.

1. Select one or more publish destinations from those available.

To create additional publish destinations, go toProfiles > Publish Destinations.
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2. Click Save.
3. Click theEncode Settings tab to continue.

Select Encode Settings
In the Encode Settings tab, you select what kinds of encodings you want going to each of the previously selec-
ted publish destinations.

1. Click to expand a publish destination, if needed.
2. Select the types of encodings you want to publish to that destination.

For information on the available encoding types, seeAvailable Encoding Settings.

If an encoding type has an XML file available to include, an XML symbol shows up after you enable the
encoding type.

3. Click XML to include an XML file with the processed presentation. For some publish destinations, XML
is required and is enabled automatically.

For more information about this XML file, seePublish XML File with an Encoding.

4. Repeat for each publish destination.
5. Click Save.
6. Click thePublish Accounts tab to continue.

Select Publish Accounts
In the Publish Accounts tab, you select the account to use for each publish destination/encoding combination.

1. Click to expand a publish destination, if needed.
2. Select an account to use for each of the encodings for the publish destination.

The account currently set as the default account for the publish destination is automatically selected.

You can:

Keep the selected account

Select another account

Select Use presenter account

This option allows presenters to enter their own credentials. Presenters will need to log in to the
TechSmith Relay website and enter their credentials.

Select Use default account

This option allows the profile to access the default account information at the time of profile pro-
cessing. Youmay want to use this option if the default account information changes from time
to time.

If you want to use the same account for all encodings under a publish destination, you
can use the top level dropdown box to select the account.

3. Repeat for each publish destination.
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4. Click Save.
5. Click theNotification Selection tab to continue.

Select Notifications
In the Notification Selection tab, you select which notifications you want to use in the profile.

1. Select one or more notifications to use with the profile.

All configured notifications are shown for you to choose from.

You do not have to select a notification for the profile to be valid. If you choose to not
include notifications in the profile, the only way for a presenter or administrator to tell if a
presentation has finished processing is to go toPresentations page, locate the present-
ation, and view the status.

2. Click Save.
3. Click theNotification Assignment tab to continue.

Assign Notifications
In the Notification Assignment tab, you select the encodings you want to associate with each previously
selected notification. Each notification only includes information about the encodings associated with it.

1. Click to expand a notification, if needed.
2. Under each notification, all publish destination/encoding combinations for the profile are shown.
3. Select the encodings you want to assign to the notification.

4. Repeat for each notification.
5. Click Save.
6. Click theVariable Definition tab to continue.

Define Profile Variables
From the Profiles dropdown, select Profile List, then choose a profile from the list. In the Profile Setup, click
on the Variable Definition tab to define the value for any profile variables that are used in the profile. You only
need to fill in values if you have previously created and used a profile variable in another part of the profile,
such as a file path or notification.
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1. Enter a value for each profile variable used in this profile.

2. Click Save.
3. Click the Associated Users tab to continue.

Associated Users
In the Associated Users tab, you select users to associate with the profile. This gives the selected presenters
access to the profile in TechSmith Relay Recorder.

1. In the Available Users list, click to select a presenter.

Presenters are shown in the list in the following format: Display Name (username). For example: Mary
Smith (m.smith)
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To select multiple presenters, hold downSHIFT orCTRL as you select users from the
list.

2. Click Add to associate presenters with the profile.
3. If you would like to have this profile automatically associated with all new presenters as they are added

to TechSmith Relay, enable theAutomatically associate this profile with new users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > Sys-
tem Options > Auto Associate Profiles and enable theAutomatically associate
selected profiles with new users option. When you return to the Associated Users
tab of a profile, you will see the option.

4. Click Save.
5. Click theOverview tab to continue.

Review the Profile
In the Overview tab, you can see and review the setup of a profile.

You can click the Information icon to access more information about one of the following:

Publish destinations

Publish accounts

Encode settings

Notifications

Presenters that are associated with this profile are able to see this same overview when they
log in to the website.

When you have reviewed the profile setup, click theProfile Test tab to continue.

Test the Profile
In the Profile Test tab, you can process a sample presentation to verify that the profile behaves as you expect.

TechSmith Relay provides a pre-recorded presentation so you can test the behavior of the profile without hav-
ing to install the recorder and record a presentation.

1. Select a presenter to test the profile. This presenter's information is used, if needed, for variables,
accounts, etc.

Youmay want to make sure the presenter knows that you are going to test the profile, or use your own
presenter account.

The presenters available in the list are the users associated with this profile.

2. Select whether or not you want to test the notifications associated with the profile.
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3. Select whether or not you want to include theHold for caption editing process in the profile test.
4. Click Test Profile.

TechSmith Relay submits a sample presentation and processes it with the settings of the profile.

5. You are redirected to thePresentations page where you can follow the progress of the presentation’s
processing.

4. Add Users to TechSmith Relay
There are different ways to add users to TechSmith Relay.

If your organization:

Uses LDAP, seeConfigure TechSmith Relay to Use LDAP.

Does not use LDAP, seeManually Add Users to TechSmith Relay.

After adding presenters, global caption editors, and other administrators, you shouldSet User Account
Security Settings.

Use More than One Kind of User

TechSmith Relay allows you to use both LDAP users and TechSmith Relay created users.

Some examples of why youmay want to use both LDAP and TechSmith Relay managed users:

You use LDAP and need a temporary account for a visiting presenter.

You use LDAP and need a presenter account for someone already in the system as an administrator.

Configure TechSmith Relay to Use LDAP
To configure LDAP, you should first set up a RelayPresenter Service Account.

RelayPresenter Service Account

Prior to configuring TechSmith Relay to work with LDAP, we recommend creating a “RelayPresenter” service
account in your LDAP directory and associate this account when you bind credentials in LDAP. Use this
account to perform the initial step in authenticating users.

When a user tries to authenticate over LDAP, TechSmith Relay uses this “RelayPresenter” user to search the
LDAP directory and retrieve the user’s qualified domain name. The user’s qualified domain name is given to
the LDAP directory along with their password for authentication.

TechSmith Relay never stores LDAP passwords with the exception of the password of this service account.

The service account should have a password that does not expire. TechSmith Relay ceases
to function for all users if the password of the service account in LDAP is not the same as the
password stored in the TechSmith Relay database.

Configure TechSmith Relay to Use LDAP

1. Go toUsers > LDAP Configuration.
2. Click Configure LDAP.
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3. Enter server information:
Server address

Port
Use secure authentication: Select if you want to connect to the LDAP server over SSL.

Trust all certificates: Enable if you cannot connect over SSL due to an invalid certificate.
If you have a valid self-signed certificate, import the signing certificate into the Trusted
Root Certificate Authority on the TechSmith Relay Server for better security.

Authenticationmethod (Basic or Negotiate)

Username & password to authenticate

4. Click Next.
5. Select the returned base distinguished name or enter another.

TechSmith Relay returns the root of the LDAP directory, and pre-fills the Base distinguished name
field. Or, if you know exactly where your users reside in the LDAP directory, you canmanually enter
the Base DN.

6. Click Next.
7. Select the “RelayPresenter” service account as the representative user with the following attributes:

Full name

Username

Email address

8. Click Next.
9. Map the attributes from the selected user to the fields TechSmith Relay requires.

You can choose from the dropdown list of attributes returned from LDAP or type in an attribute if it is
not found in the dropdown list.

10. Click Next.
11. Review the configuration information.
12. Enter a valid username and password into the Test Authentication fields and click Test.
13. Click Finish.

You can now configure TechSmith Relay to Automatically Import Users with LDAP or .

If you disable LDAP, users remain in the TechSmith Relay database. However, since
TechSmith Relay never stores LDAP-associated passwords, users cannot access the
TechSmith Relay website or make recordings.

To re-enable users, select a user then click theConvert to Relay link. The user is emailed a
randomly generated password. The user must access the TechSmith Relay website and
change their random password.
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Automatically Import Users with LDAP

To ease administration of TechSmith Relay, you can enable a system option to import an LDAP user when
they log into TechSmith Relay (website or recorder) with valid LDAP credentials.

Use this option in conjunction with automatically assigning profiles for the easiest way to
get TechSmith Relay set up when you use LDAP authentication.

Automatically Add Users with LDAP

1. Go toSystem > System Options > Auto Import Users.
2. Enable the option toAutomatically import users with valid LDAP credentials.
3. Click Save.

As presenters successfully log in to either the TechSmith Relay website or the TechSmith Relay recorder
with LDAP usernames and passwords, they are automatically added to TechSmith Relay. If you enabled
Auto Associate Profiles, presenters can access the selected profiles immediately. This is a great way to
reduce the amount of administration work for getting new users started with TechSmith Relay.

Manually Import Users with LDAP

TechSmith Relay can reference an LDAP directory to populate the user database. There are two ways to
import users into the TechSmith Relay database.

At the end of the LDAP setup wizard, click Manually import users to import users immediately.

When LDAP is enabled you can also import users from theUsers > LDAP Import page.

1. From the Import LDAP page, you can search for LDAP users or groups in the left pane, or you can use
the upper-right pane to search by username, name, email, or LDAP attributes.

2. Once your search has returned results, check the box to the left of the users you want to add, or select
all by checking the box in the top row.

3. Choose the role to assign the selected users with the "Add with" dropdown.
4. Click Add Users.

Once the users are added, you will find them on the Users > User List page.

To view a user's complete list of attributes, select a single user in the list, and click View Details in their
Account Info section.

Manually Add Users to TechSmith Relay
If you do not use LDAP for authentication, you can create users manually in TechSmith Relay.

You can have both LDAP and TechSmith Relay created users. SeeMore than One Kind of
User.
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Create a New User

1. Go to theUser List page.
2. Click theNew User button.

3. Enter a username.

This is the username the presenter uses to log in to the TechSmith Relay website and recorder.

4. Enter the name (given name) of the user.
5. Select Presenter orGlobal Caption Editor from the Access Level dropdown list.

NoAccess restricts the user from logging into the website and Recorder. For example,
you can use it to turn off a presenter’s privileges at the end of a semester/term.

6. Enter the user’s email address.
7. Enter and confirm a password.
8. Click Save, or you can click Save & Add to immediately add another user.

Set User Account Security Settings
To help secure TechSmith Relay, you can set the following:
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Recorder Security Settings

Forgot Password Settings

Account Lockout Settings

Password Complexity

Activate / Deactivate TechSmith Relay Server
Activate TechSmith Relay server to remove the trial period and activate the correct number of encoding pro-
cessors. It is important to deactivate TechSmith Relay server before you uninstall the server so you can
install TechSmith Relay on another server.

To communicate with the activation server through a firewall, port 80must be open.

Activate the TechSmith Relay Server

1. Click System > Activation.
2. Enter your license code and click Activate.

Obtaining More Activations

If you find that you need additional activations for your server, please contact a sales associate at 1-800-517-
3001 (US) or 1-517-381-2300 x636 (international) and wewill walk you through the process of updating your
license.

Offline Activation/Deactivation

If TechSmith Relay is installed on a private network, offline activation and deactivation allows you to deac-
tivate without connecting to the Internet.

Activate when offline

1. Log in to the TechSmith Relay website as an administrator and go toSystem > Activation.
2. Click Offline Activation.
3. A window opens and contains an Installation ID number.
4. Contact a TechSmith sales associate at 1-800-517-3001 (US/Canada) or 1-517-381-2300 x636 (inter-

national).
5. Provide the Installation ID and License code to the sales associate. The sales associate gives you an

Unlock Code.

Your license code was emailed in the TechSmith Relay purchase receipt.

6. Enter the code into the field provided. TechSmith Relay is now activated.

To deactivate when offline

1. Log in to the TechSmith Relay website as an admin and go toSystem > Activation.
2. Click Offline Activation.
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3. A window opens. Click Deactivate to deactivate the server.
4. The window closes and you return to page. The server is now shown in an Expired state.
5. Contact a TechSmith sales associate at 1-800-517-3001 (US/Canada) or 1-517-381-2300 x636 (inter-

national).
6. Provide the Proof of Removal code and the Installation ID to the sales associate. This decrements the

number of activations on your license code in the event that you want to activate a different server.

Problems with Activation/Deactivation

In the event of hardware failure or problems, please contact TechSmith.

US and Canada: +1-800-517-3001

International: +1-517-381-2300 x636

Please be ready with your Installation ID, License code orProof of removal code (in the case of deac-
tivation). Your license code was emailed in the TechSmith Relay purchase receipt.

Verify Setup
The purpose of this step is to ensure everything is set up properly. It also helps you better understand the “big
picture” of TechSmith Relay and should help youmake better decisions when implementing TechSmith Relay
on a large scale.

Verify the Installation

1. Add yourself as a userwith presenter access. (Administrators cannot make recordings.)
2. Associate your presenter account to a profile.
3. Download a recorder from System > Download Recorders and install. (It is recommended to not

install the TechSmith Relay recorder on the server as ameans of verifying your setup.)
4. Log in to the TechSmith Relay recorder. Enter the presenter account username and password created

on the TechSmith Relay website (e.g. don’t use the RelayAdmin username).
5. Select a profile.
6. Record your desktop activity for aminute or two. Stop the recording and click Submit.
7. Sign in to the TechSmith Relay website using the same username and password you entered into the

recorder. You can view the status of your recording and experience the website from a presenter point
of view.

8. Verify that the presentation processes and publishes correctly.

Roll-Out TechSmith Relay
Here’s a checklist of suggested steps when introducing TechSmith Relay to presenters.

Verify all presenters have valid profiles associated with their accounts.

Youmight wish to roll-out TechSmith Relay in stages. For example, start with one department instead
of the whole company or campus.
What training do presenters require? You can direct presenters to the overview video launched from the
helpmenu of the recorder and the videos located in the help section of the TechSmith Relay website.
(Administrators see a different help page.)
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Decide if you will install the TechSmith Relay recorder on user computers, if you will direct users to
obtain and install the recorder on their own, or if you will Deploy TechSmith Relay Recorder. The
recorder has the TechSmith Relay server URL “baked-in” based on the server from which it was down-
loaded. If you put a copy of the TechSmith Relay recorder on a website or network drivemake sure you
got it from the server you want people to use.
Establish a clear policy for how presenters should do things like request new profiles or profile changes
or request a new password.
Prepare an introduction email for presenters. We’ve created a few samples you canmodify.

See also

What Presenters Need to Know Most

Sample Emails Administrators Can Modify and Send to Presenters

What Presenters Need to Know Most
You need to communicate the following to presenters. You can use this information in an email introducing
TechSmith Relay to your presenters.

There are helpful videos

Get presenters to watch the overview accessible from the login screen of the recorder and in the Help section
on the TechSmith Relay website. Youmay want to send presenters directly to the video so they can review
TechSmith Relay before accessing the Recorder or having to sign in to the TechSmith Relay website.

Make a test recording

There’s a blue TEST button in the TechSmith Relay recorder presenters can use to verify they are recording
the correct screen and that audio is recording properly. Nothing is worse than recording an hour presentation
with no audio.

How uploading works

As soon as the presenter clicks theSubmit button in the recorder, the recording gets ready to upload in the
background.

There is no visual indication of progress.

If the recorder is offline (or loses Internet access), the recording automatically uploads (or resumes
uploading) as soon as the computer gains Internet access.
Presenters receive an email when the presentation is published.

Presenters can check the upload, encoding and publishing progress if they log in to the TechSmith
Relay website.

Sample Emails Administrators Can Modify and Send to Presenters
Email examples for:

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=5.0.0&lang=enu&os=na
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Presenters Integrated with Your LDAP System

Presenters Not Integrated with Your LDAP System

Presenters That Must Supply Publish Destination Account Information

Presenters Integrated with Your LDAP System

Subject: Your TechSmith Relay Account andGetting Started Information

Body: Greetings! This email contains everything you need to know to start recording presentations with
TechSmith Relay. Use TechSmith Relay on your computer to record whatever is on your screen—Power-
Point, Keynote, websites, etc. Once you submit the recording, our TechSmith Relay server will process the
file and publish the presentation in a variety of formats in convenient locations.

Where to start?

TechSmith Relay requires a username and password. Good news! You don’t have to remember
another password. Use the same username and password you use to access our [work, school, uni-
versity] network.
Install TechSmith Relay [either direct users to the TechSmith Relay website or make the installer avail-
able in some other manner].

Questions? Problems?

Please direct all questions and feedback to your TechSmith Relay Administrator.

Presenters Not Integrated with Your LDAP System

Subject: Your TechSmith Relay Account andGetting Started Information

Body: Greetings! This email contains everything you need to know to start recording presentations with
TechSmith Relay. Use TechSmith Relay on your computer to record whatever is on your screen—Power-
Point, Keynote, websites, etc. Once you submit the recording, our TechSmith Relay server will process the
file and publish the presentation in a variety of formats in convenient locations.

Where to start?

TechSmith Relay requires a username and password.
Your username is:

Your password is:

You can change your password by signing into the TechSmith Relay website [URL here] and
clicking theAccountsmenu.

Install TechSmith Relay [either direct users to the TechSmith Relay website or make the installer avail-
able in some other manner].

Questions? Problems?

Please direct all questions and feedback to the TechSmith Relay Administrator.

Name:

Email:

Phone:
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Presenters That Must Supply Publish Destination Account Information

For example, presenters need to enter usernames and passwords to a network drive, personal FTP site or
Screencast.com account.

Subject: Please supply account information for TechSmith Relay

Body: Your TechSmith Relay account is all set up and almost ready to go. There’s just one last step. In order
to publish your presentations, you need to enter your username and password for [publish destination].

To enter your account information:

Sign in to the TechSmith Relay website [URL].

You will immediately see a yellow “Action Required” banner with a link to the account with missing inform-
ation. Click the link and enter your information.

Questions? Problems?

Please direct all questions and feedback to the TechSmith Relay Administrator.

Name:

Email:

Phone:

Deploy TechSmith Relay Recorder
In a locked-down or controlled environment, the administrator can choose to deploy the TechSmith Relay
Recorder forWindow operating systems, instead of having the users download it from the TechSmith Relay
website.

TheWindows Installer client can be found on the server at:

[INSTALLDIR]_installhelper\TechSmithRelayRecorder.msi

This MSI can be distributed via the usual methods; creating aWindows Installer Transform file or using the
command line switches. The "Properties" that need to be assigned values are as follows.

Critical Properties

PRIMARYENDPOINT: TechSmith Relay server URL.

TEAMID: TeamingGUID. This property should be only used when teamingmultiple servers together.

Optional Properties

INSTALLDIR: Main destination folder.

TSC_PP_ADDIN: Set to 0 to disable the TechSmith Relay Recorder Add-in for Microsoft PowerPoint.

TSC_START_NOW: Set to 0 to keep TechSmith Relay Recorder from launching after installation.

TSC_DESKTOP_LINK: Set to 0 to not create a shortcut to TechSmith Relay Recorder on the Desktop.
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Example

msiexec.exe /i “\\Apps_server\TechSmithRelayRecorder.msi”

PRIMARYENDPOINT="https://relaydev01.techsmith.com/relay/rest.ashx"

TEAMID="FE47DE98-9E88-414b-A99F-C24F26951D7F" TSC_DESKTOP_LINK=0

/qb-!
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TechSmith Relay Administration Refer-
ence
The following topics provide reference information for TechSmith Relay administrators. Use these topics to
find out information about specific TechSmith Relay pages.

System Menu

Presentations Menu

Profiles Menu

Users Menu

System Menu
The Systemmenu allows you tomanage the TechSmith Relay system and view related options. The fol-
lowing pages are available in this menu:

System

Servers

System Options

Plug-Ins

Activation

Client Machines

Event Log

Download Recorders

System
The System page contains information to help you configure TechSmith Relay and a Dashboard to provide a
quick overview of the system status at a glance.

Important Configuration Steps

This component of the System page contains the threemost important steps for configuring the TechSmith
Relay system:

Define Publish Destinations

Set Up Notifications

Create Profiles

For more information on configuration, seeConfiguration of TechSmith Relay.
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Dashboard

The Dashboard provides you with a quick look at what is going on with the TechSmith Relay system. On this
page, you can find the following:

Presentation Actions Necessary / Recent Presentations

If there are any actions you need to take to allow presentations to process, they
show here. For example, a presentation is uploaded using the Upload and Decide
Later profile.

Click an item in the list to go to the page where you can take action for that item.
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If there are no presentations that need action, this area shows a list of the tenmost
recent presentations.

Click a link to view information about the completed presentation, including links to
the published presentations, when available.

System Messages / Servers

This area alerts you of any important issues that you need to address in the
TechSmith Relay system.

If there are no alerts, the current count of various system components is displayed.

If you have invalid profiles indicated in the list, go to theProfiles page where the
invalid profiles are shownwith an error status in the profile list.

Encoder Usage

The Encoder Usage graph displays the peak encoder usage and average encode
capacity of a TechSmith Relay server. Peak encoder usage is themaximum num-
ber of queued and processing encode jobs during that time period, while average
encode capacity is how often the encoder was busy during the time period.

If the time period is less than a week, the data is displayed by the hour.

If the time period is more than a week, the graph displays peak and average usage
by day. The average displayed for a day is the highest hour of that day. The entire
time it takes to process an encoding is tracked (including any time the encoding job
is waiting in the queue), but time spent uploading and captioning the presentation is
not.

Use this chart to track peak usage times, see when the encoding server is at its
busiest, or to find out if the encoding server is overloaded and unable to process all
the presentations it receives in a timely manner.

Average File Size by Encoding

The Average File Size chart shows the average file size (in megabytes) per minute
of video for each encoding type used during the time period. The graph shows aver-
ages across each group of encoding types, grouped by encode format. Clicking an
encoding group shows the average of each specific encode type.

Encode Speed / Recorded Minute

The Encode Speed graph shows the average time a presentation processed with a
specific profile takes to encode, in minutes of encode time per minute of present-
ation video. Themain view is the time from when the first encoding type begins until
the last encode type ends. Click a specific profile to see a breakdown of the encode
speed for each encoding type included in that profile.

Only the 10most used profiles appear on the Encode Speed graph.

System Panel

This area shows the current number of presentations, servers, profiles, invalid pro-
files, presenters, administrators, as well as recent client machines. Click a link to
visit the relevant page for more information.
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Servers
The Servers page contains information about and lets you interact with servers running TechSmith Relay.

If you havemultiple servers to handle processing presentations, you have a “teamed” server
environment. On the Servers page of each teamed server, you can access the other servers in
the team.

Server Status Icons

Icon Status Description

Online Currently accepting and processing presentations.

Offline Currently not accepting new presentations, but still processing existing
presentations.
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Icon Status Description

Shutdown Currently not accepting or processing presentations.

Error The Event Log in the Systemmenuwill havemore information on a
server error.

Change Server Status

Take a server offline

When you take a server offline, the server stops accepting new presentations, but continues to pro-
cess presentations it has already received.

Shutdown a server

If you need to completely stop a TechSmith Relay server (to upgrade, for example) take the server off-
line and then wait until all jobs are Completed and click Shutdown.

Verify all presentations have completed prior to shutdown. Any presentations that are
not completed will be canceled. When the server is brought back online, all canceled
jobs are automatically retried.

Bring a server back online

When you are ready to bring the server back into service, select it from the server list and click Bring
Server Online.

When you are ready to bring the server back into service, select it from the server list and click
Bring Server Online.

System Options
System Options include:

Auto Associate Profiles

Auto Import Users

Portable Recorder Options

Email Notifications

Auto Associate Profiles

To ease administration of TechSmith Relay, you can choose specific profiles to automatically assign to new
users. Use this option when you want all presenters to have a common profile or set of profiles.

Profiles are only assigned to users when they are first added to TechSmith Relay. Changes
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made to the automatically assigned profiles list are not reflected on existing TechSmith Relay
users.

Automatically Associate Profiles

1. Go toSystem > System Options > Auto Associate Profiles tab.
2. If needed, enable the option toAutomatically associate selected profiles with new users. (This

option is enabled by default.)
3. Select a profile in the dropdown list and click Add. Repeat to add all required profiles to the list.
4. Click Save.

Manage Auto Associate Setting for Single Profile

1. Go toProfiles.
2. Click a profile.
3. Click theAssociated Users tab.

4. At the bottom of the page, enable or disable theAutomatically associate this profile with new
users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > System
Options > Auto Associate Profiles and enable theAutomatically associate selected pro-
files with new users option. When you return to the Associated Users tab of a profile, you
will see the option.
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Other System Options

Auto Import Users

Portable Recorder Options

Email Notifications

Auto Import Users

To ease administration of TechSmith Relay, you can enable a system option to import an LDAP user when
they log in to TechSmith Relay (website or recorder) with valid LDAP credentials.

Use this option with automatically assigning profiles for the easiest way to get TechSmith
Relay set up using LDAP authentication.

Automatically Add Users with LDAP

1. Go toSystem > System Options >Auto Import Users.
2. Enable the option toAutomatically import users with valid LDAP credentials.
3. Click Save.

As presenters successfully log in to either the TechSmith Relay website or the TechSmith Relay Recorder
with LDAP usernames and passwords, they are automatically added to TechSmith Relay. If you enabled
Automatically Assign Profiles, the presenters can access the selected profiles immediately.

Other System Options

Auto Associate Profiles

Portable Recorder Options

Email Notifications

Portable Recorder Options

Administrators can decide how they would like presenters to access the portable recorder. Choose from the
following:

Option Description

Available
by down-
load only

The portable recorder is available on the website.

Presenters can log in to the website and download the portable recorder and
transfer it to amobile storage device, such as a USB drive.

Use this option if presenters are reasonably “technical” and understand down-
loading and unzipping files.

Available
by email
request

There is a button available on the website to request a portable recorder.

Presenters can log in to the website and click this link to send an email request to
the administrator. The administrator receives an email with the request.
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Option Description

only
Use this option if presenters are “not technical” andmay not understand down-
loading and unzipping files. You can put the portable recorder on amobile storage
device and give it to the presenter.

Not avail-
able

There is no way for a presenter to download or request a portable recorder.

Use this option if you will handle distributing all portable recorders or do not want
to use the portable recorder in your organization.

Even if they do not have access to the portable recorder, presenters are still able
to find information about it in the help and other locations.

For information about how to upload presentations from a portable recorder, seePortable Recorder.

Other System Options

Auto Associate Profiles

Auto Import Users

Email Notifications

Email Notifications

With installation and initial configuration of TechSmith Relay, you are asked to provide email server inform-
ation. You can also choose to enable or disable email notifications from TechSmith Relay.

These notifications includemessages directly from the system:

Password changes

Trial expiration

Server disk space warnings

Presentations needing attention

Presentations held for captioning

This option does not affect any profile notifications.

To update your email notification setting:

1. Go toSystem > System Options > Email Notification tab.
2. Enable or disable theEnable email notifications option.
3. Click Save.

To hide the Send Feedback link in emails, deselect the Hide feedback link in emails option.
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The feedback is sent to TechSmith and won't impact administration of your TechSmith Relay
server.

Other System Options

Auto Associate Profiles

Auto Import Users

Portable Recorder Options

Send Usage Data

By default, the Send Usage Data option is enabled. This means that anonymous information about your hard-
ware and the usage of TechSmith Relay is sent, securely, to TechSmith. No personal information about your
organization or presenters is sent.

To disable this option, uncheck Automatically sends usage data to TechSmith.

To see the actual data being collected, use the Information Gathering Application. The Information Gathering
Application is located here: C:\Program Files\TechSmith\Relay Server-
\Manager\InfoGathering.exe

Formore on the type of information collected, see the help file included in the Information Gathering Applic-
ation.

Plug-Ins
Plug-ins aremodules that you can install to add additional publish destinations or notification options to
TechSmith Relay. TechSmith Relay comes with various plug-ins available to install for both publish des-
tinations and notification servers:

Name Plug-In Type Installed by Default?

Blackboard Notification No

Email Notification Yes

Moodle Notification No

Amazon S3 Publish Destination No

Drupal Publish Destination No

File System Publish Destination Yes

FTP Server Publish Destination Yes

iTunes U Publish Destination No

Kaltura Publish Destination No
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Name Plug-In Type Installed by Default?

Mediasite Publish Destination No

Screencast.com Publish Destination Yes

Microsoft Windows SharePoint Publish Destination No

WebDav Publish Destination No

YouTube Publish Destination No

The list of plug-ins that are installed by default is for a new installation. When upgrading from a
previous version of TechSmith Relay, any plug-ins that were installed prior to the upgrade are
still available.

Additional plug-ins may periodically become available. Instructions to add a new plug-in to your server will be
provided with the plug-in.

See also

Install a Plug-In

Remove a Plug-In

Install a Plug-In

Before a plug-in is available to use, youmust first verify and install the plug-in.

1. Once a plug-in is available on your server, go toSystem > Plug-Ins.
2. Locate the plug-in in the list and click Verify.

The TechSmith Relay server verifies that it can load the plug-in. Once the plug-in is verified, an Install
button appears.

3. Click Install.

If the plug in installs correctly, the button disappears.

4. Complete setup for the newly added plug-in:

Go toProfiles > Publish Destination Setup to access publish destinations.

Go toProfiles > Notification Server Setup to access notification servers.

See also

Remove a Plug-In.

Remove a Plug-In

Before you can remove a plug-in, it cannot be in use.
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1. Go toSystem > Plug-Ins.
2. Determine if the plug-in is in use.

If the plug-in is not in use, there is aRemove button available for the plug-in.

If theRemove button is not available, check the following pages to see where the plug-in is in
use and delete any dependencies:

Profiles > Publish Destination Setup

Profiles > Publish Account Setup

Profiles > Notification Server Setup

Profiles > Notification Setup

3. Click Remove.

The plug-in is removed from use but is not removed from the server. All files related to the plug-in are
still available on the server. The plug-in stays in the list and can be installed again.

See also

Install a Plug-In.

Activation
Activate TechSmith Relay server to remove the trial period and activate the correct number of encoding pro-
cessors.

Whenmoving to a new server, it is important to deactivate TechSmith Relay server before you
uninstall the server so you can install TechSmith Relay on another server.

Activate/Deactivate the TechSmith Relay Server

1. Go to System > Activation.
2. Enter your License code and click Activate (or Deactivate).

Offline Activation/Deactivation

If TechSmith Relay is installed on a private network, offline activation/deactivation allows you to do so
without connecting to the Internet.

You can activate and deactivate TechSmith Relay server by contacting TechSmith by phone.

US and Canada please call: +1-800-517-3001

International please call: +1-517-381-2300 x636

Please be ready with your Installation ID, License code (orProof of removal code in the case of deac-
tivation). Your license code was emailed in the TechSmith Relay purchase receipt.

Assistance with Activation

In the event of hardware failure or problems, please contact TechSmith.
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US and Canada please call: +1-800-517-3001

International please call: +1-517-381-2300 x636

Please be ready with your Installation ID, License code or (or Proof of removal code in the case of deac-
tivation). Your license code was emailed in the TechSmith Relay purchase receipt.

Client Machines
On the Client Machines page, you can view information about the client machines for the server. Use this
information to troubleshoot problems or verify that presenters download updated recorders, if needed.

You can view the following:

Computer name

IP address

Client type (Windows or Mac)

Version of the TechSmith Relay Recorder

Last connection

Last user to connect (with link to more information)

Last presentation information (with link to more information)

Diagnostic information (with link to download a log file)

Event Log
On the Event Log page, you can sort events to troubleshoot problems. Available information includes the fol-
lowing:

Type

Date/Time

Server

Source

Details

You can also filter the list based on:

Errors

Warnings

Messages

Sources

Download Recorders
Access and download all the TechSmith Relay Recorders.
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If you want to record a presentation, youmust have a presenter account. You cannot log in to
any of the TechSmith Relay recorders as an administrator.

When presenters download the recorder, any available plug-ins and add-ins are also installed on the
presenters’ computers:

Windows
Presenters are given the option in the TechSmith Relay recorder installer to install the
TechSmith Relay Add-In for Microsoft Office PowerPoint. This add-in allows a presenter to
easily record a PowerPoint slide show with TechSmith Relay from inside of PowerPoint. See
the TechSmith Relay recorder help for more information.
Presenters that are also running Camtasia Studio 5.1 and above are provided with a plug-in that
allows for sending a Camtasia Studio project to the TechSmith Relay server for production and
publishing. An option to produce with TechSmith Relay is added to the production process in
Camtasia Studio automatically when both programs are installed on the same computer.

Mac

Presenters that are also running Camtasia for Mac 1.2 and above are provided with a plug-in that
allows for sending a Camtasia for Mac project to the TechSmith Relay server for production and pub-
lishing. An option to share with TechSmith Relay is added to Camtasia for Mac automatically when
both programs are installed on the same computer.

For information on the portable recorder, seePortable Recorder.

Portable Recorder

Provide the portable recorder to presenters if there is any reason that presenters cannot (or should not) record
and upload directly from the presentation computer. For example:

Presenters record on computers where they do not have permission to install applications.

Presenters record on computers that have limited or no network access.

You want to collect the presentations and upload them collectively at a later time.

You want to have presenters contact an administrator to receive a portable recorder.

You want to install the TechSmith Relay portable recorder on amobile storage device and distribute to
presenters.

You can select how you want presenters to access the portable recorder on theSystem Options page.

Create a Portable Recorder

Use the following process to install the portable recorder on amobile storage device, such as a USB flash
drive.

1. Plug in amobile storage device with aminimum of 4GB storage and format the device as FAT32.
2. Click Download Portable Recorder and save the ZIP file to your computer.
3. Locate and open PortableCamtasiaRelayRecorder.zip.
4. Copy all files from the ZIP file onto themobile storage device.
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All files from the ZIP file need to be copied to the root of the device for the TechSmith Relay
portable recorder to autorun onMicrosoft Windows operating systems.

Upload Presentations from a Portable Recorder

To upload presentations from a portable recorder:

1. Connect the portable recorder to a computer with the desktop version of the TechSmith Relay
Recorder installed on it.

2. Make sure that the desktop TechSmith Relay recorder is not running and open the TechSmith Relay
portable recorder.

3. Click theView Saved Presentations button.

4. The Saved Presentations dialog opens.

5. Click Submit All to submit all of the presentations for upload or click to submit individual present-
ations.

You can submit saved presentations at any time.

If you are online and connected to the server, your presentations start to upload.

If you are offline, your presentations are stored on the computer and automatically upload to the server
once you are online and connected.

After you upload saved presentations, you cannot access or view your presentation or the
status of the upload in the TechSmith Relay Recorder. You can check the status of the
presentations on thePresentations page of the TechSmith Relay website.

Presentations Menu
The Presentations menu allows you to view andmanage presentations. The following pages are available in
this menu:

Presentations

Job Status

History

Presentations
The Presentations page allows you to view presentations by state and take action to resolve issues.

Presentations in all states have the following information:

User name and email of presenter that submitted the presentation

Date and time the presentation was recorded
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Computer name, with link to diagnostic information on theClient Machines page

Presentation description, if entered by the presenter

Profile used, with link to view and edit profile

Duration of presentation

Resolution of presentation

You can view presentations on the server by the following states:

States Description

Needs
Attention

Use the information and options provided to resolve issues so the presentation
can process. Includes a list of presenters and a list of profiles to select from. You
can also delete presentations.

Processing
View the progress of a processing presentation. You can see the progress of
each job associated with the presentation, including transcription, encoding, pub-
lishing, and notifications.

Uploading View the upload progress and cancel upload, if needed.

Completed

View the status of presentations that have completed processing. For some pub-
lish destinations, links are included to view the published presentation. Select
Remove from List to permanently remove a presentation from the Completed
list.

Deleted View information about any deleted presentations.

Failed Use the information provided to figure out why a presentation failed. Includes
status information to show you which part of processing failed.

Held for
Captioning

View the presentations held for caption editing. When caption editing is complete
or to skip caption editing, click Release Hold to continue processing the present-
ation. Only presenters can edit captions; administrators can only release a hold.

Job Status
The Job Status page allows you to view and sort jobs on the TechSmith Relay server or teamed servers. You
can filter jobs by the following:

Status
Queued

Processing

Failed

For failed jobs, expand the presentation information to resubmit or delete the
presentation.
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Canceled

Pending

Type
Encoder

Publisher

Server
All servers

Specific server

History
The History page allows you to view the history of TechSmith Relay presentations. You can do the following
with the items on this page:

Item Description/Action

Presentation
Title

Click to expand and view more information on the presentation. Includes profile,
client machine, processing progress, andmore.

Presenter The username of presenter that recorded the presentation. Click the username
to view more information about the presenter.

Server The name of the server processing the presentation. Click to view the status of
the server.

Recording
Date/Time Date and time that the presentation was recorded

Presentation
Status

Icons show the status of the presentation.

Uploading

Processing

Complete

Needs Attention

Failed

Deleted

Jobs
Queued

Jobs Pro-
cessing

Icons show the status of jobs for the presentation.
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Item Description/Action

Jobs
Canceled

Uncover More Information

You can drill down to findmore information on the presentations by expanding the presentation information
and clicking available links.

For example, if you’d like to see information about the source recording files for a presentation, you could:

1. Click a presentation to expand the available information.
2. Click the down arrow to expand an encoding action from the list.
3. Click View Encoding Files.

4. A new browser tab or page opens to show you information about the source files and the files produced
during encoding. Use this information for testing or troubleshooting.

Profiles Menu
The Profiles menu allows you to create andmaintain profiles and related items. The following pages are avail-
able in this menu:

Profiles

Publish Destination Setup

Publish Account Setup

Notification Server Setup
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Notification Setup

Variables

Profiles
Profiles are the backbone of TechSmith Relay. They allow presenters to record without having tomake any
decisions about how the presentations are processed or where they are placed for viewing.

Profile setup involves settings and information found on the following tabs:

Profile Settings

Publish Destinations

Encode Settings

Publish Accounts

Notification Selection

Notification Assignment

Variable Definition

Overview

Profile Test

Information about Profiles

Upload and Decide Later Profile

The Upload and Decide Later Profile uploads the recorded presentation to the TechSmith Relay server
but the recording is not encoded or published. An authorized presenter or TechSmith Relay admin-
istrator must assign a different profile and submit the recording for publishing via the TechSmith Relay
website.

Why use the Upload and Decide Later Profile?

For guest presenters, it is the only profile available.

Youmake a presentation in advance, but do not want it published until later.

You are not satisfied with existing profile options and wish to hold the recording on the server
until you can contact your TechSmith Relay administrator to create or modify a profile.

Tab Status Icons

Each tab shows its current status. The status icons are as follows:

Everything on this tab is valid and in working order.

Something on this tab is not quite right. Youmight want to verify that you are not
missing anything. This does not make a profile invalid.
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Example: There are no notifications selected.

There is an error on this tab. You will need to enter or correct information before this
profile can be used.

Example: There are publish destinations without encode settings selected.

Create a New Profile

To create a new profile:

1. Go toProfiles.
2. Click theNew Profile button.

The Profile Setup page opens.

3. Work through, from top to bottom, the tabs at the left side of the page.

Profile Settings

In the Profile Settings tab, you enter some basic information about the profile.

1. Enter a title for the profile.

Remember that the profile title is the only thing presenters can see in the recorder. The profile descrip-
tion is only visible on the website. Consider carefully how you choose profile titles so that they convey
their intended use to presenters.

2. Enter a description.
3. Select the Transcription Settings.
4. Click Save.

See also

Transcription Options

Publish Destinations

Encode Settings

Publish Accounts

Notification Selection

Notification Assignment

Variable Definition

Overview

Profile Test
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Transcription Options

TechSmith Relay provides an optional transcription process that allows you to include a full audio search, cap-
tions, or both in presentations. The available options are:

No transcription

Presentation audio is not transcribed.

Captions and full audio search

Presentation audio is transcribed for captions and full audio search in Flash and Silverlight encodings.
Choose one of the web or Silverlight encoding options to make this available for viewers.

When audio transcription is complete, the presentation is put into a Held for Captioning state on the
Presentations page. There the presenter can review and edit the transcribed audio and release the hold
to continue processing the presentation.

Full audio search only

Presentation audio is transcribed to provide a full audio search in Flash and Silverlight encodings, but
no captions are shown in the presentation.

If you want to publish a different encoding type, you can still gain some benefits from transcription. For
example, enable the XML file (when available) to make the transcribed audio available as metadata in
the file. You can use this metadata for other uses, such as searching within amedia server.

Can be captioned by Presenter only

Presentation captions can only be edited by the presenter who uploaded the presentation.

Can be captioned by Presenter and Global Caption Editors

Presentation captions can be edited by the presenter who uploaded the presentations or any
Global Caption Editor.

The transcription process adds time to presentation processing.

See also

Profile Settings

Publish Destinations

Encode Settings

Publish Accounts

Notification Selection

Notification Assignment

Variable Definition
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Overview

Profile Test

Publish Destinations

On the Publish Destinations tab, you select the publish destinations you want to use for presentations pro-
cessed with the profile.

1. Select one or more publish destinations from those available.

To create additional publish destinations, go toProfiles > Publish Destinations.

2. Click Save.

See also

Publish Destination Setup

Publish Account Setup

Profile Settings

Encode Settings

Publish Accounts

Notification Selection

Notification Assignment

Variable Definition

Overview

Profile Test

Encode Settings

On the Encode Settings tab, you select what kinds of encodings you want going to each of the previously
selected publish destinations.

1. Click to expand a publish destination, if needed.
2. Select the types of encodings you want to publish to that destination.

For information on the available encoding types, seeAvailable Encoding Formats.
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If an encoding type has an XML file available to include, an XML symbol shows up after you enable the
encoding type.

3. Click XML to include an XML file with the processed presentation. For some publish destinations, XML
is required and is enabled automatically.
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For more information about this XML file, seePublish XML File with an Encoding.

4. Repeat for each publish destination.
5. Click Save.

Available Encoding Settings

The table below contains descriptions of the encoding formats available in TechSmith Relay. TheMP4
with Smart Player encoding is recommended for use inmost situations. This setting utilizes the TechSmith
Smart Player to create an output with a video player that includes an HTML5 playbback. The Smart Player
plays great on desktop browsers, on iPhones and iPads, and onmany other mobile devices that support MP4
video. It supports Table of Contents, Speech to Text, and Closed Captioning.

If transcription is enabled on the Profile Settings tab, youmust include a Flash or Silverlight
encoding format or include an XML file with the encoding to utilize the transcribed audio.

Preset Format
Includes
Camera
PIP?

Description

Image (PNG, JPG, GIF) PNG, JPG,
GIF No

This encode setting produces a
single image file with the same
format as the original upload.
Use this if you want to upload
images.
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Preset Format
Includes
Camera
PIP?

Description

MP4with Smart Player

480p

720p

1080p

(Small) 640x480

(Medium) 800x600

(Large) 1024x768

(Up to 1080p)

MP4 Yes

This encode setting creates an
MP4 video file that is displayed
in an HTML5 controller called the
TechSmith Smart Player. Addi-
tional files are created to provide
an Flash fallback player in cases
where the HTML5 is not avail-
able.

The Smart Player plays great on
desktop browsers, on iPhones
and iPads, and onmany other
mobile devices that support MP4
video. The Smart Player sup-
ports a table of contents based
on the titles of slides in a Power-
Point or Keynote presentation,
as well as slide text, full audio
search, and captions (if
enabled).

MP4 (480p) MP4 Yes

This encode setting creates an
MP4 video file with no additional
files. The final resolution of the
video is fixed at 480p.

MP4 (720p) MP4 Yes

This encode setting creates an
MP4 video file with no additional
files. The final resolution of the
video is fixed at 720p.

MP4 (Up to 1080p) MP4 Yes

This encode setting creates an
MP4 video file with no additional
files. The file is the same dimen-
sions as the original recording up
to 1080p.

MP3 MP3 No

This is an audio-only encode set-
ting. The server can process this
encoding extremely fast, and the
resulting file size is small. This
is a good encode setting for
those whomay want an audio-
only version of their present-
ation.

Camtasia for Mac Recording ZIP >
CMPROJ No

This encode setting generates a
lossless video file for editing
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Preset Format
Includes
Camera
PIP?

Description

within Camtasia for Mac. This
encoding should only be given to
presenters with access to
Camtasia for Mac.

The resulting file is a ZIP file
that, when opened on aMac,
automatically unzips into a dir-
ectory. The user can double-
click that directory to launch the
CMPROJ in Camtasia for Mac.

Camtasia Studio 7.1.1 and
Earlier Recording CAMREC Yes

This encode setting generates a
.camrec file for use with
Camtasia Studio versions 5.1 to
7.1. The CAMREC contains
PowerPoint and Keynote slide
and title clip markers. This
encoding should only be given to
presenters with access to
Camtasia Studio.

When publishing a .camrec file
to a location with a valid web
URL, the resulting notification
includes a “View” link. Because
web servers do not have aMIME
type set up for .camrec files, the
link leads to a 404 error page.

Camtasia Studio 8.0 and Later
Recording

(Original size)
CAMREC Yes

This encode setting generates a
.camrec file for use with
Camtasia Studio version 8.0 and
later. The .camrec file contains
PowerPoint and Keynote slide
and title clip markers. This
encoding should only be given to
presenters with access to
Camtasia Studio.

When publishing a TREC file to
a location with a valid web URL,
the resulting notification includes
a “View” link. Because web serv-
ers do not have aMIME type set
up for TREC files, the link leads
to a 404 error page.

Windows Media WMV Yes This encode setting creates
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Preset Format
Includes
Camera
PIP?

Description

(Small) 640x480

(Medium) 800x600

(Large) 1024x768

(Original Size)

video files that play inWindows
Media Player. The video files
tend to be larger than the Flash
and Silverlight encodings, but
may be preferred by Windows
users with high speed internet
access.

YouTube MP4 Yes

This encoding is only available
for the YouTube publish des-
tination. This is used for pub-
lishing directly to YouTube using
the YouTube publishing plug-in.
The video is subject to
YouTube's restrictions.

Unsupported Presets
(as of version 5.0) Format

Includes
Camera
PIP?

Description

AVI (Original Size) AVI Yes

This encode setting produced a
single AVI file with the same res-
olution as the original recording.
This file was used if you wanted
to perform your own video pro-
cessing and encoding. Note that
AVI files usually have a larger
file size than presentations
encoded in other formats.

The recommended encode set-
ting is MP4 (up to 1080p). Like
the AVI (Original Size), this set-
ting produces a single file and
maintains the resolution of the
original recording (up to 1080p).

Original Recording (Backup)

AVI (Win-
dows)

MOV
(Macintosh)

Recording
and camera
video are
two sep-
arate files

This encode setting did not
modify the original recorded file
in any way. The file size was
enormous and usually not con-
sidered viewer-friendly.

For those switching from theOri-
ginal Recording (Backup), the
MP4 (Up to 1080p) is recom-
mended. Not only does theMP4
play nicely on bothWindows and
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Preset Format
Includes
Camera
PIP?

Description

Macintosh platforms, this setting
will maintain the resolution of the
original recording, which could
be helpful for backup purposes
or troubleshooting.

Silverlight

(Small) 640x480

(Medium) 800x600

(Large) 1024x768

(Original Size)

XAP Yes

This encode setting created
video files that played in
Microsoft Silverlight. The con-
troller supported a table of con-
tents based on the titles of slides
in a PowerPoint or Keynote
presentation, as well as search-
ing slide text, full audio search,
and captions, if enabled.

TheMP4 with Smart Player is
recommended for those used to
theMicrosoft Silverlight con-
troller. This setting will produce
the video file with the TechSmith
Smart Player, which supports a
table of contents based on the
titles of slides in a PowerPoint or
Keynote presentation, as well as
slide text, full audio search, and
captions (if enabled).

Windows Portable Media
Player WMV No

This encoding was designed to
provide a solution forWindows
Mobile Devices (Pocket PCs)
and someWindows-based
Smartphones.

iPad MP4 Yes

This encode setting created
video files with varied final res-
olutions to provide a good view-
ing experience for a given video
on an iPad.

iPod and iPhone MP4 Yes

This encode setting worked on
all iPods and iPhones that sup-
port video. The final resolution of
the video was fixed at 640 x 480.
Th video looked good on all
iPods and iPhones, but not if
played in QuickTime on a
desktop computer.
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Publish XML File with an Encoding

TechSmith Relay provides administrators with the option to generate XML files for published presentations.
For some publish destinations, XML is required and is enabled automatically.

The XML data contains information about the presentation such as the title, length, format, resolution, and
more. When you enable the transcription process inProfile Settings, the XML also contains the transcription
of the presentation audio.

Customers may use the XML file with existingmedia-hosting solutions, content delivery methods such as
RSS feeders, etc. TechSmith provides the XML data as a service, but does not support how the institution
uses the XML file.

XML data is available for all encode types and all supported publish destinations with the following excep-
tions:

XML is not included with presentations published to iTunes U.

XML data is parsed into fields (as opposed to a single XML file) for presentations published to Screen-
cast.com. Themetadata can be found under Details when viewing a presentation on Screencast.com.

Information Included in the XML File

Presentation information: title, description, date, duration, and resolution

Profile used to create presentation

Presenter name

Client (computer used tomake the recording) IP address, and computer name

Server namewhere recording was processed

Encoding preset used

Length of time the presentation was in the queue for processing

Length of time it took to encode the presentation

Destination URL of published presentation

See also

Profile Settings

Publish Destinations

Publish Accounts

Notification Selection

Notification Assignment

Variable Definition

Overview

Profile Test
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Publish Accounts

In the Publish Accounts tab, you select the account to use for each publish destination/encoding combination.

1. Click to expand a publish destination, if needed.
2. Select an account to use for each of the encodings for the publish destination.

The account currently set as the default account for the publish destination is automatically selected.

You can:

Keep the selected account

Select another account

Select Use presenter account

This option allows presenters to enter their own credentials. Presenters need to log in to the
TechSmith Relay website and enter their credentials.

Select Use default account

This option allows the profile to access the default account information at the time of profile pro-
cessing. Youmay want to use this option if the default account information changes from time
to time.

If you want to use the same account for all encodings under a publish destination, you
can use the top level dropdown box to select the account.

3. Repeat for each publish destination.
4. Click Save.

See also

Publish Account Setup

Publish Destination Setup

Profile Settings

Publish Destinations
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Encode Settings

Notification Selection

Notification Assignment

Variable Definition
Overview

Profile Test

Notification Selection

In the Notification Selection tab, you select which notifications you want to use in the profile.

1. Select one or notifications to use with the profile.

All configured notifications are shown for you to choose from.

You do not have to select a notification for the profile to be valid. If you choose to not
include notifications in the profile, the only way to tell if a presentation has finished pro-
cessing is to go to Presentations page, locate the presentation, and view the status.

2. Click Save.

See also

Notification Setup

Profile Settings

Publish Destinations

Encode Settings

Publish Accounts

Notification Assignment

Variable Definition

Overview

Profile Test

Notification Assignment

In the Notification Assignment tab, you select the encodings you want to associate with each previously
selected notification. Each notification only includes information about the encodings associated with it.

1. Click to expand a notification, if needed.
2. Under each notification, all publish destination/encoding combinations for the profile are shown.
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3. Select the encodings you want to assign to the notification.

4. Repeat for each notification.
5. Click Save.

See also

Notification Setup

Profile Settings

Publish Destinations

Encode Settings

Publish Accounts

Notification Selection

Variable Definition

Variable Definition

On the Variable Definition tab, you define the value for any profile variables that are used in the profile. You
only need to fill in values if you have previously created and used a profile variable in another part of the profile,
such as a file path or notification.
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1. Enter a value for each profile variable used in this profile.

2. Click Save.

See also

Variables

Profile Settings

Publish Destinations

Encode Settings

Publish Accounts

Notification Selection

Notification Assignment

Associated Users

In the Associated Users tab, you select users to associate with the profile. This gives the selected presenters
access to the profile in TechSmith Relay Recorder.
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1. In the Available Users list, click to select a presenter.

Presenters are shown in the list in the following format: Display Name (username). For example: Mary
Smith (m.smith)

To select multiple presenters, hold downSHIFT orCTRL as you select users from the
list.

2. Click Add to associate presenters with the profile.
3. If you would like to have this profile automatically associated with all new presenters as they are added

to TechSmith Relay, enable theAutomatically associate this profile with new users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > Sys-
tem Options > Auto Associate Profiles and enable theAutomatically associate
selected profiles with new users option. When you return to the Associated Users
tab of a profile, you will see the option.

4. Click Save.
5. Click theOverview tab to continue.

Overview

On theOverview tab, you can see and review the setup of a profile.

You can click the Information icon to access more information about one of the following:

Publish destinations

Publish accounts

Encode settings

Notifications
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Presenters that are associated with this profile are able to see this same overview when they
log in to the website.

See also

Profile Settings

Publish Destinations

Encode Settings

Publish Accounts

Notification Selection

Notification Assignment

Variable Definition

Profile Test

On the Profile Test tab, you can process a sample presentation to verify that the profile behaves as you
expect.

Basically, TechSmith Relay provides a pre-recorded presentation so you can test the behavior of the profile
without having to install the recorder and record a presentation.

1. Select a presenter to test the profile. This presenter's information is used, if needed, for variables,
accounts, etc.

Youmay want to make sure the presenter knows that you are going to test the profile, or use your own
presenter account.

The presenters available in the list are the users associated with this profile.

2. Select whether or not you want to test the notifications associated with the profile.
3. Select whether or not you want to include theHold for caption editing process in the profile test.
4. If you choose not to send notifications, you can view the status of the sample presentation on the

Presentations page.
5. Click Test Profile.

TechSmith Relay submits a sample presentation and processes it with the settings of the profile.

6. You are redirected to thePresentations page where you can follow the progress of the presentation’s
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processing.

See also

Overview

Google Drive Configuration
1. Go to https://yourrelayserver/relay/PluginList.aspx and install the Google Drive plug-in.
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2. Then, navigate to https://yourrelayserver/relay/ImportSourceSetup.aspx and copy the redirect URL.

3. In a new browser window, sign in to https://console.developers.google.com. If you do not have a
Google account, create one and then sign in.

4. Create a new project.

https://console.developers.google.com/
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5. From the Project Dashboard, go to the APIs & auth tab, select APIs, and enable both the Drive API
and Drive SDK options.

6. Then select the Credentials tab, and click Create a new Client ID to open a developer console.
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7. Paste the redirect URL from your clipboard into the console as shown below. The authorized Javas-
cript origins should be the base URL of your TechSmith Relay server.

8. Click Create Client ID. A Client ID and Client Secret are generated for you.
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9. Return to https://yourrelayserver/relay/ImportSourceSetup.aspx, paste the Client ID and Client Secret
into their respective fields, and click Save.

10. Optional: If you would like to use the TechSmith Relay icon for the Google Drive consent screen, you
can paste the following link into the APIs & Auth > Consent screen in the Google developer console in
the LOGO field:
http://assets.techsmith.com/Images/content/mkt-product-camtasiaRelay/Relay-icon.png

Publish Destination Setup
TechSmith Relay can publish presentations to one or more of the following locations. Click the publish des-
tination type to learnmore.

File System (Network drives, etc)

FTP Server (FTP & sFTP)

Screencast.com (TechSmith’s media-hosting service)

WebDAV

Microsoft Windows SharePoint

iTunes U (TechSmith Relay formats supported by iTunes U includeMP4 andMP3)

Kaltura

http://assets.techsmith.com/Images/content/mkt-product-camtasiaRelay/Relay-icon.png
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Mediasite

Drupal

YouTube

Amazon S3

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

Publish to Amazon S3

To create an Amazon S3 publish destination:

1. Click Profiles > Publish Destinations.
2. Click Amazon S3 on the left to create a new destination.
3. Enter a title, the Amazon Access Key, and Amazon Secret Key.

The access key and secret key are provided by Amazon.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

AmazonWeb Services, the “Powered by AmazonWeb Services” logo, and Amazon S3 are trademarks of
Amazon.com, Inc. or its affiliates in the United States and/or other countries.

See also

File System

Screencast.com

WebDAV

Microsoft Windows SharePoint

iTunes U

Kaltura

Mediasite
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Drupal

YouTube

Publish to Drupal

TechSmith Relay currently supports release 6.1 and 7 of Drupal. The TechSmith Relay Drupal
plug-in has been tested with version 6.1.9 and version 7.2.

1. Click Profiles > Publish Destinations.
2. Click Drupal on the left to create a new destination.
3. Enter all required information and select FTP and XMLRPC protocol options.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

File System

FTP Server

Screencast.com

WebDAV

Microsoft Windows SharePoint

iTunes U

Kaltura

Mediasite

YouTube

Amazon S3

Publish to File System

To create a file system publish destination:

1. Go toProfiles > Publish Destination Setup.
2. Click File System on the left to create a new destination.
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3. Enter all required information. Use variables to help createmulti-purpose publish destination paths and
URLs, as needed.

4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

FTP Server

Screencast.com

WebDAV

Microsoft Windows SharePoint

iTunes U

Kaltura

Mediasite

Drupal

YouTube

Amazon S3

Publish to FTP Server

To create an FTP (or sFTP) publish destination:

1. Click Profiles > Publish Destinations.
2. Click FTP Server on the left to create a new destination.
3. Enter all required information. Use variables to help createmulti-purpose publish destination paths and

URLs, as needed.
Use the dropdown to select from :

http

https

mms
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rtmp

rtsp

Use the dropdown to select between FTP or sFTP protocol.

4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System

Screencast.com

WebDAV

Microsoft Windows SharePoint

iTunes U

Kaltura

Mediasite

Drupal

YouTube

Amazon S3

Publish to iTunes U

1. Click Profiles > Publish Destinations.
2. Click iTunes U on the left to create a new destination.
3. Enter all required information.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.

iTunes U Publishing Requirements

TechSmith Relay can publish presentations directly to iTunes U provided the following conditions are sat-
isfied:
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Your institution has an iTunes U account. TechSmith is not affiliated with iTunes U.

The published presentations are encoded into a file type supported by iTunes U. TechSmith Relay
offers MP4, andMP3. (iTunes U supports M4A, MP3, MP4, M4V, MOV, and PDF.)
You know the Shared Secret code provided to your school by Apple. This is a 32 character alpha-
numeric code.
You have access to desiredMedia Group ID codes. These are 10-digit numbers that direct the pro-
ducedmedia into a specific instructor’s class. Learn how to find your Media Group ID.
Viewers need iTunes on their computers.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

File System

FTP Server

Screencast.com

WebDAV

Microsoft Windows SharePoint

Kaltura

Mediasite

Drupal

YouTube

Amazon S3

Publish to Kaltura

TechSmith Relay can automatically publish presentations to Kaltura and KalturaMediaSpace™.

Custom Data in Kaltura

To allow TechSmith Relay to publish to Kaltura, your Kaltura account must have Custom Data enabled. To
verify this option is enabled, log in to your Kaltura administrator account and go to Settings.

If you do not see a Custom Data tab under Settings, please contact Kaltura support.

Configure TechSmith Relay to Publish to Kaltura

1. Go toProfiles > Publish Destinations.
2. Click Kaltura on the left to create a new destination.
3. Enter a title for the publish destination.
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4. Enter the Service URL.
5. Enter the Partner ID and Administrator Secret.

To locate this information, log in to the KalturaManagement Console and go toSettings > Integration
Settings.

6. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination. SeeKaltura Publish Accounts for additional information.

7. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System

FTP Server

Screencast.com

WebDAV

Microsoft Windows SharePoint

iTunes U

Mediasite

Drupal

YouTube

Amazon S3

Publish to Mediasite

TechSmith Relay currently supports and has been tested with release 5.5 of Mediasite.

1. Click Profiles > Publish Destinations.
2. Click Mediasite on the left to create a new destination.
3. Enter all required information and select the FTP protocol option.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.
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If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System

FTP Server

Screencast.com

WebDAV

Microsoft Windows SharePoint

iTunes U

Kaltura

Drupal

YouTube

Amazon S3

Publish to Screencast.com

To create a Screencast.com publish destination:

1. Click Profiles > Publish Destinations.
2. Click Screencast.com on the left to create a new destination.
3. Enter a default folder. You can use variables to help automatically personalize the folder name.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

What is Screencast.com?

Screencast.com is the place to share your high-quality videos, documents, presentations, and images—
simply and professionally. We never compress or alter your content...so what you upload is what viewers
see. And with four levels of privacy controls, you get to decide who sees what.

Benefits of Publishing to Screencast.com

Presenters can easily manage, organize, and delete their presentations.

Presenters can attach additional materials to the video. For example, a viewer can download notes, the
actual presentation slides, etc.
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Screencast.com is hosted by TechSmith and is helpful for customers with limited bandwidth and
media storage space.
Presenters can exercise individual control over how their content is protected.

Presenters can allow viewers to comment on their presentations. See http://www.screen-
cast.com/answers for more information.

Presenter Accounts for Screencast.com

When publishing to Screencast.com, set the Publish Accounts to Use presenter account.

Every TechSmith Relay presenter needs a Screencast.com account. To obtain Screencast.com accounts,
visit http://www.screencast.com. Accounts are not created via TechSmith Relay.

By default, presentations are stored in the TechSmith Relay folder on Screencast.com. TechSmith Relay
Administrators can createmultiple Screencast.com destinations for organizational purposes, and can also cre-
atemultiple folders for presenters. Presenters may also create their own folders on Screencast.com and
assign them to their profile.

Inform Presenters

Presentations are not published until presenters sign in to the TechSmith Relay website and enter their
account information. Ideally, introduce presenters to the TechSmith Relay website and have them enter their
Screencast.com information beforemaking recordings.

Presenters that make a recording and upload a presentation before the information is entered receive an email
with a hyperlink and instructions to solve the problem.

See also
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Publish to Microsoft Windows SharePoint

Microsoft® Windows® SharePoint™websites allow users to share information, collaborated on documents,
andmanagemedia.

http://www.screencast.com/answers
http://www.screencast.com/answers
http://www.screencast.com/
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For additional information about Microsoft Windows SharePoint, see the training portal at:
http://www.microsoft.com/learning/en/us/training/sharepoint.aspx.

To create a SharePoint publish destination:

1. Go toProfiles > Publish Destination Setup.
2. Click SharePoint on the left to create a new destination.
3. Enter the SharePoint URL.
4. If you have an invalid certificate on your SharePoint server that is not currently trusted by your

TechSmith Relay server, enable the option to Trust All Certificates. This allows TechSmith Relay to
ignore any certificate errors and publish to the SharePoint server.

5. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also
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Publish to WebDAV

WebDAV (Web-based Distributed Authoring and Versioning) provides a way tomanage files over HTTP. It
allows web server directories to display as folders on a local computer. WebDAV lets you use these folders
like any other folder on the local computer. The URL that you publish a presentation to is the same as the URL
you use to view the presentation.

http://www.microsoft.com/learning/en/us/training/sharepoint.aspx
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For additional information about WebDAV, please seeWebDAV Resources online at
www.webdav.org.

To create aWebDAV publish destination:

1. Go toProfiles > Publish Destination Setup.
2. ClickWebDAV on the left to create a new destination.
3. Enter theWebDAV URL.

If you want to publish to a SharePoint server, youmust create a SharePoint publish
destination; you cannot use aWebDAV publish destination to send presentations to a
SharePoint server.

4. If you have an invalid certificate on yourWebDAV server that is not currently trusted by your
TechSmith Relay server, enable the option to Trust All Certificates. This allows TechSmith Relay to
ignore any certificate errors and publish to theWebDAV server.

5. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

See also
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Amazon S3

http://www.webdav.org/
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YouTube Configuration

The YouTube Data API lets you incorporate YouTube functionality into your own application. To configure
TechSmith Relay (Self-Hosted) for YouTube integration, refer to the following steps:

1. Go to https://yourrelayserver/relay/PluginList.aspx and install the YouTube plug-in from the list
provided.

2. Then, navigate to https://yourrelayserver/relay/PublishSettingList.aspx, click on the YouTube tab and
copy the redirect URL.

3. In a new browser window, sign in to https://console.developers.google.com. If you do not have a
Google account, create one and then sign in.

4. Create a new project or open an existing project.
5. From the Project Dashboard, go to the APIs & auth tab, select APIs, and enable YouTube Data API

v3.

https://console.developers.google.com/
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6. Then select the Credentials tab, and click Create a new Client ID to open a developer console.

7. Paste the redirect URL from your clipboard into the console as shown below. The authorized Javas-
cript origins should be the base URL of your TechSmith Relay server.

8. Click Create Client ID. A Client ID and Client Secret are generated for you.
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9. Return to https://yourrelayserver/relay/PublishSettingList.aspx, and paste the Client ID and Client
Secret into their respective fields, and click Save.

Publish to YouTube

To create a YouTube publish destination:

1. Click Profiles > Publish Destinations.
2. Click YouTube on the left to create a new YouTube publish destination.
3. Enter a title and select a category that is applied to all videos published to this destination.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.

If the YouTube publish destination is not available in the list of publish destinations, youmay
have to install the appropriate plug-in before you can use it. SeeYouTube Configuration for
more information.

Presenter Accounts for YouTube

YouTube accounts have a length limit for videos uploaded to unverified accounts. Be sure publish accounts
(either a default account or individual presenter accounts) are verified to ensure that videos uploaded through
TechSmith Relay will be accepted.



www.techsmith.com - 77 -

Videos that are longer than YouTube's length limit will be discarded by YouTube. To avoid losing videos that
YouTubemay reject, it is recommended that profiles publishing to YouTube also create a copy of the original
recording.

Before videos can be published to a YouTube account, that account must have a channel. For
more information on creating a channel for a YouTube account, see the documentation on
YouTube.com.

See also
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Publish Account Setup
For each publish destination, you can define the accounts for TechSmith Relay to use to access it.

Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

See additional account information for iTunes U Accounts andKaltura Publish Accounts.

To Create a Publish Account

1. On the Publish Account page (Profiles > Publish Accounts Setup), click one of the publish des-
tinations you have set up.

2. Enter information for the new account.
3. Select if you want to make the account the default account. See the tips below for information about

default accounts.
4. If not a default account, select if you want toUse account information from default account. This

allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

5. Click Save.
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Things to Consider About Publish Accounts

The following informationmight help you inmaking some decisions when creating your publish accounts.

You can let presenters enter their own information.

If you would like to use this option, you do not have to set up a publish account. Instead, you will select
toUse presenter accountwhen configuring a profile.

Each publish destination can have a default account.
This can be helpful in several ways:

You can set up a default account to hold the credentials used to access a publish destination,
and then use the other accounts to place presentations into various folders.
When you select a publish destination and encode setting in a profile, the default account is
selected automatically for the publish account.
If the default account for a publish destinationmay change from time to time, you can select
Use default accountwhen configuring a profile. You can then change which account is the
default account without having to change anything in the affected profiles. The profiles use the
currently selected default account for a given publish destination.

You can select different publish accounts for each publish destination/encode setting combination in a
profile.

iTunes U Accounts

Each iTunes U course requires aMedia Group ID. TheMedia Group ID is a 10-digit number supplied by Apple.
Each instructor usually has aMedia Group ID for each class.

1. Click the New account link.
2. Enter theMedia Group ID. The remaining fields are optional, but they can be helpful when assigning

iTunes U publish destinations to profiles.
3. Click Save. There is a delay as TechSmith Relay verifies the settings with iTunes U.
4. Add additional accounts as necessary. iTunes U will be available as a publish destination for encode

types supported by iTunes U.

What is My Media Group ID?

iTunes 11 and later

1. Log in to your iTunes U account in iTunes 11 or later as an administrator.
2. Click on the category you wish to retrieve theMedia Group ID from.
3. On the right side of the screen, click onUpload and Manage Files.
4. TheMedia Group ID is in the URL.
5. Paste the URL into a document. It will look similar to:

https://deimos.apple.com/WebObjects/Core.woa/

BrowsePrivately/example.com.1927435401.01099125312

6. TheGroup ID is the last 10 digits in the URL, indicated in this example in bold (1099125312).
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iTunes 10 and earlier

1. Click on a class in iTunes U.

2. Right-click the Videos tab and select Copy iTunes Store URL.

3. Paste the URL into a document. It will look similar to:

https://deimos.apple.com/WebObjects/Core.woa/

BrowsePrivately/example.com.1927435401.01099125312

4. TheGroup ID is the last 10 digits in the URL, indicated in this example in bold (1099125312).

Kaltura Publish Accounts

Accounts for Kaltura publish destinations define how presentations are published to Kaltura and KalturaMedi-
aSpace™.

1. Enter a Title for the publish account.

This title is meant to help administrators understand what a specific account is meant for during profile
creation. Try to use descriptive naming conventions for easy identification.

2. Select if you want to make the account the default account. See Things to Consider about Publish
Accounts for information about default accounts.

If not a default account, select if you want toUse account information from default account. This
allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

3. Enter the Creator for this account.

By default, the Creator field is filled in with the system variable PresenterUserName. This variable is
replaced with the presenter's user name associated with a presentation during publishing. This variable
is a great choice if user names are the same in both TechSmith Relay and Kaltura, as presentations
will automatically map to the correct Kaltura user.

4. Enter any Tags for this account, using commas to separate entries. Tags are searchable in Kaltura and
KalturaMediaSpace.

5. Enter any Categories associated with this account.Categories define where (which tab, hierarchy,
etc.) a presentation is published on a KalturaMediaSpace site.

6. Click Save.

Notification Server Setup
You can configure notifications from three types of servers:
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Email Server

Blackboard Server

Moodle Server

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

Email Server Configuration

You configure the email server when you first log into TechSmith Relay after installation.

If you need to later modify the email server information, go toProfiles > Notification Server Setup > Email
Server tab.

You can only have one email server configured in TechSmith Relay.

The configuration includes:

The SMTP email server address (Required)

The SMTP email server port (Required)

The name and email address that shows in the Reply To fields of email notifications

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

Blackboard Server

Moodle Server

Blackboard Server Configuration

TechSmith Relay can automatically post announcements on Blackboard. Configuring Blackboard announce-
ments is a two-step process. First, install the TechSmith Relay Building Block on Blackboard and establish
the Shared Secret. Next, configure TechSmith Relay to publish Blackboard announcements.

The configuration steps vary depending on your version of Blackboard Learn™. TechSmith
Relay currently supports release 9.1. The TechSmith Relay Blackboard plug-in has been
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tested with version 9.1.407.

Install TechSmith Relay Building Block

1. Locate the TechSmith Relay Building Block (RelayAnnounce.war) installed during the server install-
ation at: C:\Program Files\Techsmith\Relay Server\Blackboard Building Block.

2. Go to your Blackboard site. E.g. http://blackboard.example.com.
3. Click User Login and sign in as a System Administrator.
4. Click theSystem Admin tab.
5. Click Building Blocks.

6. Click Installed Tools.
7. Click theUpload Building Blocks button.
8. Under Install Building Block, browse to RelayAnnounce.war. Click Open.
9. Click theSubmit button and verify the Building Block is available.

10. Click theSettings button. This displays the Shared Secret.
11. Choose and enter a secure Shared Secret, andmake a note of it as you need to enter the Shared

Secret into TechSmith Relay.

Configure a Blackboard Server

1. Go toProfiles > Notification Server Setup > Blackboard Server tab.

2. Enter a title (name) for the server.

3. Enter the Blackboard URL and Shared Secret.

4. Click Save.

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.
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See also

Email Server

Moodle Server

Moodle Server Configuration

TechSmith Relay can automatically post notifications on aMoodle server. ConfiguringMoodle notifications is
a two-step process. First, configure theMoodle server to receive the notifications; next, configure TechSmith
Relay to publish notifications toMoodle.

Configure a Moodle 2.0 or Later Server to Receive Notifications

Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications

Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications

Configure TechSmith Relay to Send Notifications to Moodle

Troubleshooting Sending Notifications to Moodle

The configuration steps vary depending on your version of Moodle. TechSmith Relay currently
supports version 2.0 and later and 1.9. The TechSmith Relay Moodle plug-in has been tested
with Moodle versions 1.9.5, 1.9.6, 1.9.7, and 1.9.9. Version 2.x has been tested with up to ver-
sion 2.2.

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

See also

Email Server

Blackboard Server

Moodle 2.0 and Later Plug-In Setup

Enabling TechSmith Relay to send publish notifications to aMoodle 2.0 or later server requires two steps.
This topic covers the first, installing and configuring the plug-in on theMoodle server. The second is step is to
Configure TechSmith Relay to Send Notifications to Moodle.

Install the TechSmith Relay Plug-In on the Moodle Server
1. On your TechSmith Relay server, navigate to C:\Program Files\TechSmith\Relay Server-

\Moodle Components\.
2. Extract the techsmith_relay.zip file to your Moodle server in the {moodle_install_dir}

/server/moodle/local/ directory.
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3. Log in to theMoodle website as an administrator and go to Home.
4. A prompt appears to upgrade the TechSmith Relay Notification plug-in. Click Update and then click

Continue to check for updates.
5. Go to Site Administration > Plugins > Web Services > External Services and verify the service shows

up in the Built-in Services List.

Configure the TechSmith Relay Plug-In on the Moodle Server
Log in to theMoodle site as an administrator. Next, Navigate to Site Administration > Plugins > Web Services
> Overview. The instructions in the overview describe how to configure the TechSmith Relay plug-in.

1. Enable web services.
2. Enable protocols. Enable XML-RPC andWeb Services Documentation.
3. Create a new user to act as the "Relay User." This user is used with the web service so TechSmith

Relay can access theMoodle server.
4. Check for user capability. The user should have appropriate capabilities according to the protocols

used. Use either an existing role or add a new Web Services role. To add a new role:
a. Go to Site Administration > Users > Permissions > Define Roles.
b. Add a new role.
c. Give the new role System and User context types.
d. Allow capabilities for this role.

i. Allow Web Service: XML-RPC protocol > Use XML-RPC protocol
ii. Allow Forum > Start New Discussions.

5. Add the new role to the "Relay User" account created earlier. Go to Site Administration > Users > Per-
missions > Assign User Roles

a. Click on theWeb Service or other role and assign to the "Relay User."
b. Go to Site Administration > Users > Permissions > Check System Permissions to verify that

the TechSmith Relay User has the required capabilities.
6. Create a token for the Relay User.

a. Go to Site Administration > Plugins > Web Services > Manage Tokens.
b. Create a new token. Select "Relay User" and TechSmith Relay Notification Service and save

changes.
c. Record the newly created token string. This is the token used to set up a notification on the

TechSmith Relay website. It must be entered on the TechSmith Relay website when setting up
the publish notification.

To finish configuring the publish notification on the TechSmith Relay website, seeConfigure TechSmith
Relay to Send Notifications to Moodle.

See Also

Troubleshooting Sending Notifications to Moodle

Moodle 1.9.x Server Configuration

Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications

Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
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Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications

These steps may also work with Moodle versions prior to 1.9.5, but this has not been verified
by TechSmith Corporation.

To support TechSmith Relay notification integration, install a new PHP file, rpclib.php, on theMoodle
server as follows:

1. Locate and copy the following file:

C:\Program Files\TechSmith\Relay Server\Moodle Components\rpclib.php

2. Paste the file to theMoodle server at:

<IIS or apache-path>/htdocs/moodle/mod/forum/rpclib.php

3. Locate the following file on theMoodle server:

.../htdocs/moodle/lang/en_utf8/forum.php

4. Add the following lines to the forum.php:

$string['forum_add_discussion1_name'] = 'forum_add_dis-

cussion';

$string['forum_add_discussion1_description'] = 'calls forum_

add_discussion';

5. On theMoodle server, log in as an administrator.
6. Navigate toNetworking > XML-RPC hosts.
7. Enable theOn option and click Save changes.

8. Navigate toNetworking > XML-RPC hosts.
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9. Add the TechSmith Relay server IP address and, optionally, a network block to the list of trusted
hosts.

Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
Moodle versions 1.9.7, 1.9.8, and 1.9.9 include several changes to the way networking and XML-RPC are
handled.

It is necessary tomakemanual updates to your Moodle database. This can be accomplished with phpMyAd-
min or MySQLCLI if you are usingMySQL; otherwise, use the appropriate utility for your database.

This procedure assumes you have a standard installation of Moodle.

1. Follow the steps used for 1.9.5 and 1.9.6.
2. Insert a new row intomdl_mnet_service to represent the forum announcement service.

id name description apiversion offer

The next highest value, for this
example, it is 4

forum
course announce-
ment service

1 1

3. Insert a new row intomdl_mnet_rpc to represent the forum announcement service.

Column Name Value

id The next highest value, for this example, it is 15
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Column Name Value

function_name forum_add_discussion_1

xmlrpc_path mod/forum/rpclib.php/forum_add_discussion1

parent_type forum

parent mnet

enabled 1

help Post amessage to a forum

profile blank

4. Insert a new row intomdl_mnet_service2rpc to link themdl_mnet_service record to themdl_mnet_
rpc record.

id serviced rpcid

The next highest value,
for this example, it is
15

The id entered into mdl_mnet_
service, for this example, it is
4

The id entered into mdl_
mnet_rpc, for this example, it
is 15

5. Insert a new row intomdl_mnet_host2service to link themdl_mnet_host record to themdl_mnet_ser-
vice record.

id hostid serviceid publish subscribe

The next
highest
value, for
this
example, it
is 1

1 (This id comes frommdl_
mnet_host defining your
Moodle server having the
forum announcement service
plugin.)

The id entered
into mdl_mnet_
service, for this
example, it is 4

1 0

The next
highest
value, for
this
example, it
is 2

0

The id entered
into mdl_mnet_
service, in this
example, it is 4

1 0

TheMySQL insert statements for the above:
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insert into mdl_mnet_service (id,-

name,description,apiversion,offer) values (4,'forum', 'course

announcement service', 1, 1);

insert into mdl_mnet_rpc (id,function_name,xmlrpc_path,parent_

type,parent,enabled,help)

values (15, 'forum_add_discussion1', 'mod-

/forum/rpclib.php/forum_add_discussion1', 'forum', 'mnet', 1,

'Post a message to a forum');

insert into mdl_mnet_service2rpc (id, serviceid, rpcid) values

(15, 4, 15);

insert into mdl_mnet_host2service (id, hostid, serviceid, pub-

lish, subscribe) values (1, 1, 4, 1, 0);

insert into mdl_mnet_host2service (id, hostid, serviceid, pub-

lish, subscribe) values (2, 0, 4, 1, 0);

Prior to using these statements, first verify the correct table ids in these insert state-
ments.

Configure TechSmith Relay to Send Notifications to Moodle

1. Go toProfiles > Notification Server Setup > Moodle Server tab.
2. Enter a title (name) for the server.
3. Enter MoodleServerURL.

For example: http://moodle.our-university.edu.

If theMoodle server is configured to use a port other than the default of 80, the URL you need to include
the port. For example, if you are runningMoodle on your own computer using port 8080, the URLwould
be http://localhost:8080.

4. Enter theServer path.

Typically this is mnet/xmlrpc/server.php or moodle/mnet/xmlrpc/server.php. This can
vary depending on your Moodle configuration.

5. Enter theService path.

Typically this is mod/forum/rpclib.php/forum_add_discussion1, if the rpclib.php is used as
provided by TechSmith.

If desired, youmay implement your own XML-RPC method using the same parameters as forum_
add_discussion1. The Service Path described above would need to be set appropriately.

6. Click Save.
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See Also

Install the TechSmith Relay Plug-In on the Moodle Server

Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications

Troubleshooting Sending Notifications to Moodle

Troubleshooting Sending Notifications to Moodle

Below is a simple Python 3.x script that can be used to troubleshoot theMoodle course announcement plug-
in. To use it, you will need to:

1. Install Python 3.0+ on a client computer.
2. Copy the script below into a file on the client computer, e.g., xmlrpc-moodle.py.
3. Edit serverUrl and server to match your Moodle server configuration.
4. Run the script like something like this: C:\python31\python.exe xmlrpc-moodle.py

# For use with Python 3.x

import sys

import time

import xmlrpc.client

timestamp = time.strftime("%Y-%m-%dT%H:%M:%S") # iso_time

# Server settings

serverUrl = "http://localhost:80/"

server = "moodle199" # can be empty if the serverUrl identifies the

server

service = "forum_add_discussion1"

username="admin"

# format and mailnow are hardcoded for now

format=1

mailnow=1

# Announcement settings

courseshortname="CHEM101"

subject="python3 test's subject " + timestamp + ", <a

href=\"http://www.techsmith.com/\">TechSmith!</a>"

message="python3 \"test's\" msg " + timestamp
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# RPC call and results

rpcServerUrl = serverUrl + server + "/mnet/xmlrpc/server.php"

service = "mod/forum/rpclib.php/" + service

xmlRpcServer = xmlrpc.client.Server(rpcServerUrl)

print("*** Calling XML-RPC service {0} on server URL {1}".format

(service, rpcServerUrl))

try:

result = xmlRpcServer._ServerProxy__request(service,

(courseshortname, subject, message, format, username,

mailnow))

print("result =", result)

except Exception as e:

print("Unexpected error:", sys.exc_info())

raise

See also

Install the TechSmith Relay Plug-In on the Moodle Server

Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications

Configure TechSmith Relay to Send Notifications to Moodle

Notification Setup
Set up notifications to let administrators, presenters, or viewers receive information about processed present-
ations.

You can set up notifications to be sent by email or posted on Blackboard or Moodle.

Create a Notification

1. On the Notification Setup page (Profiles > Notification Setup), click one of the notification servers.
2. Enter information for the notification. Depending on which server type you select, you will enter dif-

ferent types of information.

You can use variables to allow one notification to be used inmultiple cases. For more information, see
Variables.

3. Select aDetails Template to use.

Click Samples to preview what information each template includes.
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This template defines what information to include in the notification. A notification contains information
for each encoding you select to include in this notification in the profile.

ChooseMessage only if you only want to specify amessage and not include additional details.

4. Enter amessage to include in the notification. This can be a personalized greeting, additional present-
ation information, or left blank. You can use variables in this field.

5. Click Save.

Things to Consider About Notifications

The following informationmight help you inmaking some decisions when creating notifications.

When you set up a profile, you can choose which encodings you want to include in each notification.

For example, you could create a profile that contains both aWeb video and a TREC file. You can
include theWeb video information in a notification that goes straight to viewers and include information
on the TREC file in a notification that goes only to the presenter.

You can preview the information included in each of the details templates by clicking the Samples link.
For more information on the details templates, seeDetails Templates.
You can use variables to allow for a single notification to be used for multiple uses.

For example, use the system variable {s:PresenterEmailAddress} in the To field of an email noti-
fication. Any profile that uses that notification always sends an email to the email address of the
presenter associated with the presentation.

If you use variables in themessage of a notification, some variables only receive information from the
last processed encoding in a presentation.

For example, if you use the system variable {s:PublishFilePath} in themessage of a notification and
havemultiple encodings set up in the selected profile, only the file path of last published encoding are
included in themessage.

TechSmith Relay does not send separate notifications for each encoding selected in a profile, but
instead rolls information for each encoding into a single notification.

For example, if in a profile, you select to include three encoding types in a notification, the recipient
receives one notification including information about all three encodings rather than three separate noti-
fications.

Details Templates

The following details templates are available to use in your notifications. These samples contain example
information to demonstrate what information is included in notifications that use each template.

If you do not want to include any details, select theMessage Only template. This template will
only include the text you enter in themessage field.
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Administrator

Presenter
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Viewer

Variables
Variables can help simplify themanagement of profiles, publish destinations, publish accounts, and noti-
fications. These “placeholders” have a value applied to them at the time a presentation processes.

There are three different types of variables available:

System Variables

Select from variables included in the TechSmith Relay system and that change their value based on
the information for the presentation that is being processed.

Global Variables

Create a variable, use the variable in multiple places, andmanage the value in central location.

Profile Variables

Create a variable, use the variable in multiple places, and define the value per profile.

Where and How to Use Variables

Variables are available in multiple fields on the TechSmith Relay website, but you use the same interface to
access them in all locations.

Where Can I Use Variables?

Variables are available in publish destinations, publish accounts, and notifications. You can use them
to reuse file paths, URLs, folder names, email recipients, notificationmessages, andmore

Next to each field that can accept variables, you will see the Variable button.
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How Do Add a Variable to a Field?

To use a variable:

Click theVariable button to open theVariable Selectionwindow.

Select a Variable type (Global, System, or Profile).

Select a variable from the list of variables of the selected type.

Click Add. The variable is added at the cursor location.

Repeat as needed. You can use the window to add variables and to edit the content of the field.

When you are done, click OK to close the window.

System Variables

System variables have dynamic values that change based on the presentation that is being processed. These
variables are included with the TechSmith Relay system and include the following:

Variable Name Variable Value

{s:EncodeSettingTitle} Title of the encode setting used to process a presentation.

{s:PresentationDescription} Description of the presentation.
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Variable Name Variable Value

{s:PresentationDuration} Duration, in milliseconds, of the presentation.

{s:PresentationResolution} Maximum resolution in the presentation.

{s:PresentationTitle} Title of the presentation.

{s:PresenterEmailAddress} Email address of the presenter associated with the present-
ation.

{s:PresenterName} Name of the presenter associated with the presentation.

{s:PresenterUserName} Username of the presenter associated with the presentation.

{s:ProfileDescription} Description of the profile used to process the presentation.

{s:ProfileTitle} Title of the profile used to process the presentation.

{s:PublishDestinationTitle} Title of the publish destination of the presentation.

{s:PublishFileDuration} The duration of the published presentation, in milliseconds.

{s:PublishFileName} File name of the presentation.

{s:PublishFilePath} The output path of the published presentation.

{s:PublishFileSize} The file size of the published presentation.

{s:RecordDateTime} Date and time the presentation was recorded.

{s:RecorderComputerName} Name of the computer that recorded the presentation.

{s:RecorderIpAddress} IP address of the computer that recorded the presentation.

{s:RecordSettingTitle} Title of the record setting used to record the presentation.

{s:ServerUrl} URL of the server that processed the presentation.

{s:SourceFileSize} Size of the original recording of the presentation.

{s:StartProcessingDateTime} Date and time the presentation started processing.

Example Uses

Use the variable for the presenter’s username in a publish destination file path such as:

\media.company.com\presentations\{s:PresenterUserName}

When the presentation is published, the presenter’s username is substituted in the file path and places
the presentation in that presenter’s network folder.
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Use the variable for the presenter’s email, {s:PresenterEmailAddress}, in theRecipient email
field of an email notification. This notification is always sent to the presenter of the presentation,
without having to create a notification for each user.
Use the variable for the presentation title in theSubject field of an email notification. Use something
like “Presentation Ready for Viewing: {s:PresentationTitle}” to let the recipients know what present-
ation is ready from just the subject of the email.

See also

Where and How to Use Variables

Global Variables

Profile Variables

Global Variables

Global variables are static strings defined by an administrator. Changes made to the values of these variables
are instantly reflected wherever they are used in TechSmith Relay.

Create and use a global variable when you have a value that is used across multiple profiles and needs to
change at some point.

Example Uses

Create a variable forSemester and add it to a file system publish destination path, such as:

\\media.company.com\presentations\{g:Semester}

You can use this publish destination for multiple profiles. When the semester is over, change the value
on theProfiles > Variables > Global Variables tab and all profiles are automatically adjusted to
reflect the change.

Create a variable for the person to contact if a presenter needs assistance with editing a TREC file.

Use the variable in the email notification to the presenter.

When the responsibility to help presenters passes to a new person, you can easily change the variable
value on theProfiles > Variables > Global Variables tab.
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See also

Where and How to Use Variables

System Variables

Profile Variables

Profile Variables

Profile variables have dynamic values that are profile specific. These variables can be used inmultiple profiles
but the value is defined per profile.

To fill in the value for a profile variable, go toProfiles > [Select a Profile] > Variable Definition tab.

Example Use

Your organization’s network folder structure contains a “department” value. If you want a profile for each
department, create a variable for Department. Use this variable in a publish destination such as \\me-
dia.company.com\presentations\{p:Department}\{s:PresenterUserName}.

When you create a profile, you are prompted to define the value of the profile variable. In this case, the depart-
ment name that is also found in the network folder structure.

See also

Where and How to Use Variables

System Variables

Global Variables

Users Menu
The Users menu allows you tomanage TechSmith Relay users and related settings. The following pages are
available in this menu:

Users

Configure TechSmith Relay to Use LDAP

User Account Security Settings

Users
The Users page contains a list of the current users in the TechSmith Relay system. On this page you can:

Review the users in the system. At a glance, you can see:
Usernames

Name (user’s “real” name)
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Email Address

User Type (created in TechSmith Relay or imported from LDAP)

Access Level (Administrator, Presenter, Globlal Caption Editor, No Access)

Click a user to edit user information (TechSmith Relay-created users only)
Username

Name

Access level

Email address

Password

Modify a presenter’s available profiles

Delete a user

Add a TechSmith Relay user

Manually Import Users with LDAP

Automatically Import Users with LDAP

More than One Kind of User

TechSmith Relay allows you to use both LDAP users and TechSmith Relay created users.

Some examples of why youmay want to use both LDAP and TechSmith Relay managed users:

You use LDAP and need a temporary account for a visiting presenter.

You use LDAP and need a presenter account for someone already in the system as an administrator.

Manually Add TechSmith Relay Users

If you do not use LDAP for authentication, you can create users manually in TechSmith Relay.

You can have both LDAP and TechSmith Relay created users.

To Create a New User

1. Go to theUsers page.
2. Click theNew User link.

3. Enter a username.

This is the username the presenter uses to log in to the TechSmith Relay website and recorder.

4. Enter the name (given name). This is associated with the recordings.
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5. Select Presenter orGlobal Caption Editor in the Access Level dropdown list.

No Access restricts the user from logging into the website and Recorder. For example,
you can use it to turn off a presenter’s privileges at the end of a semester/term.

6. Enter an email address.
7. Enter and confirm a password.
8. Click Save orSave & Add.

Configure TechSmith Relay to Use LDAP
To configure LDAP, you should first set up a RelayPresenter Service Account.

RelayPresenter Service Account

Prior to configuring TechSmith Relay to work with LDAP, we recommend creating a “RelayPresenter” service
account in your LDAP directory and associate this account when you bind credentials in LDAP. Use this
account to perform the initial step in authenticating users.

When a user tries to authenticate over LDAP, TechSmith Relay uses this “RelayPresenter” user to search the
LDAP directory and retrieve the user’s qualified domain name. The user’s qualified domain name is given to
the LDAP directory along with their password for authentication.

TechSmith Relay never stores LDAP passwords with the exception of the password of this service account.
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The service account should have a password that does not expire. TechSmith Relay ceases
to function for all users if the password of the service account in LDAP is not the same as the
password stored in the TechSmith Relay database.

Configure TechSmith Relay to Use LDAP

1. Go toUsers > LDAP Configuration.
2. Click Configure LDAP.
3. Enter server information:

Server address

Port
Use secure authentication: Select if you want to connect to the LDAP server over SSL.

Trust all certificates: Enable if you cannot connect over SSL due to an invalid certificate.
If you have a valid self-signed certificate, import the signing certificate into the Trusted
Root Certificate Authority on the TechSmith Relay Server for better security.

Authenticationmethod (Basic or Negotiate)

Username & password to authenticate

4. Click Next.
5. Select the returned base distinguished name or enter another.

TechSmith Relay returns the root of the LDAP directory, and pre-fills the Base distinguished name
field. Or, if you know exactly where your users reside in the LDAP directory, you canmanually enter
the Base DN.

6. Click Next.
7. Select the “RelayPresenter” service account as the representative user with the following attributes:

Full name

Username

Email address

8. Click Next.
9. Map the attributes from the selected user to the fields TechSmith Relay requires.

You can choose from the dropdown list of attributes returned from LDAP or type in an attribute if it is
not found in the dropdown list.

10. Click Next.
11. Review the configuration information.
12. Enter a valid username and password into the Test Authentication fields and click Test.
13. Click Finish.

You can now configure TechSmith Relay to Automatically Import Users with LDAP or .
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If you disable LDAP, users remain in the TechSmith Relay database. However, since
TechSmith Relay never stores LDAP-associated passwords, users cannot access the
TechSmith Relay website or make recordings.

To re-enable users, select a user then click theConvert to Relay link. The user is emailed a
randomly generated password. The user must access the TechSmith Relay website and
change their random password.

Adding Dynamic LDAP Groups
To set up a new Dynamic LDAP Group, first make sure your TechSmith Relay site is configured to use LDAP.
For more on configuring TechSmith Relay for LDAP, seeConfigure TechSmith Relay to Use LDAP.

To set up an LDAP group

1. Go to Users > Dynamic LDAP Groups.
2. Click the add button to add a new group.

3. Under Group Info, enter a title for your group.
4. Select an Attribute Key, Equality, and Attribute Value if you know those values.

Attribute Key: This is the name of the attribute, or properties. When you click on the Attribute
Key dropdown, you'll be able to choose from a complete list of attribute keys.
Equality: Choose whether you want to return only exact valuematches or if you want it to just
contain the value. If only one of these options works on a query, TechSmith Relay will disable
the other, leaving only one option.
Attribute Value: This is the criteria, or data--numeric or otherwise.

If you need assistance filling out these fields, click Show existing object selector.The tree view
drops down, allowing you to navigate to existing users with the attribute you want to isolate. If you click
on the user attribute displayed on the right, it will populate the Attribute Key and Value fields. Adjust the
Equality and Value fields as needed.

5. Click Add.
6. Optional: Addmore rules (or query strings) by clicking the gray plus button. Once the group contains

more than one, anOperator field will appear and let you choose whether you want your return to have
both attributes (And), or if you want to return results with either attribute (Or).

Query String

The query string that generates on this page is LDAP syntax to search LDAP directories. That means that
LDAP administrators can enter this string into their directory program and it will return a list of users in this
group.
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To assign profiles to a group

1. Go to Users > Dynamic LDAP Groups
2. Click on the group title, and then under the Profiles Assigned section of the group page, choose an

existing profile from the dropdown.
3. Click the add a new profile button to assign the selected profile to the group.

Updating user information with LDAP changes

Individual user information will get updated with group information when one of the following happens:

The user logs in (TechSmith Relay will sync their user information with groups and respective profiles
at that time).
An administrator manually syncs the user's LDAP information from the User List page.

A user's associated dynamic LDAP groups can be viewed by going to Users > User List and clicking on a
user.

User Account Security Settings
To help secure TechSmith Relay, you can set the following:

Recorder Security Settings

Forgot Password Settings

Account Lockout Settings

Password Complexity

Recorder Security Settings

Tomanage the security of the TechSmith Relay recorders, you can choose to enable or disable the following
options.

Ignore Server Certificate Errors

If your server certificate is invalid, TechSmith Relay notifies you on theDashboard and the Recorder Secur-
ity settings page.

Enable this option if you need to let the recorder connect to the server even if the server has an invalid
server certificate. When enabled, the TechSmith Relay recorders ignore all server (SSL) certificate
errors when connecting to the TechSmith Relay server.

This option should be used as a temporary solution as it reduces the security of the
TechSmith Relay server.

Disable this option if you have security concerns and want to be sure that recorders only connect
when there are no SSL certificate errors.

More information about certificate errors:
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When you change this option, TechSmith Relay recorders will be unavailable until they are rebuilt to
reflect this security change.

It may take several minutes before the TechSmith Relay recorders are again available for download.
Allow about fiveminutes for the updated recorders to be available on theSystem > Download
Recorders page.

Recorders downloaded before changing this option cannot connect to the server andmust be updated.
Please inform presenters that they must download and install a new recorder from the TechSmith
Relay website. Presenters are not informed automatically.

Expire Recorder Authentication Codes

Enable this option to have presenter authentication codes expire. This can prevent an attacker from learning a
presenter’s code, posing as the presenter, and sending requests to the server.

This may affect presenters that select Remember me in the recorder. When the authen-
tication code expires, the presenters need to log in again.

See also

Forgot Password Settings

Account Lockout Settings

Password Complexity

Forgot Password Settings

You can allow users to change forgotten passwords. Set the amount of time (in minutes) that a change pass-
word link is active and how often users can request a new password.

See also

Recorder Security Settings

Account Lockout Settings

Password Complexity

Account Lockout Settings

You can allow accounts to lock after a given number of failed logins. Also set the length of time to lock an
account, how often to reset login attempts, and whether users can unlock accounts using CAPTCHA.

CAPTCHA Option to Unlock Accounts

CAPTCHA uses distorted text in an image to help protect websites frommalicious computer programs.
CAPTCHA helps tomake sure a person trying to access the website, not a computer program.

Enable this option to allow users to unlock their accounts by typing in the distorted text shown in the image.
Using this option should help to cut down on emails to administrators by users locked out of accounts.
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See also

Recorder Security Settings

Forgot Password Settings

Password Complexity

Password Complexity

Create rules for password complexity that adhere to organization standards. You can set the following pass-
word attributes:

Password character length

Uppercase and lowercase character requirements

Letters and numbers requirements

Special character (~!@#$%^&*.-_+?;) requirements

See also

Recorder Security Settings

Forgot Password Settings

Account Lockout Settings
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Need More Help
In addition to the in-product help files, there are several different ways to get help using TechSmith Relay.

TechSmith Relay Tutorials

Looking for “How to…?” or “How do I…?” information? In the TechSmith Relay section of the
TechSmith.com tutorials page you can find themost up-to-date tutorials and product information.

TechSmith Technical Support

Having a technical issue? In the TechSmith Support Center you can search for answers to technical
issues and contact support. SeeWorking with Technical Support for more information about how to
contact TechSmith’s Technical Support team.

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=5.0.0&lang=enu&os=na
http://www.techsmith.com/redirect.asp?target=relaysupport&product=relay&ver=5.0.0&lang=enu&os=na
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Working with Technical Support
In the event you have an issue that cannot be answered with the TechSmith Relay Help and documentation,
please follow the steps below when working with TechSmith Technical Support.

Step 1: Knowledge Base Search
Before contacting TechSmith for Technical Support, pleasemake sure to search the Knowledge Base on the
Support Center (http://support.techsmith.com). It is possible that the issue is a known issue and there is
already an answer available.

Step 2: Submit a Question
If you are unable to find an answer to your issue, send a question to Tech Support.

http://support.techsmith.com/
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Step 3: Call Tech Support
The TechSmith Relay Tech Support team is ready and waiting for your questions. Should you have problems
that you cannot solve using the resources provided, please give us a call and wewill be happy to assist.

The following information is available on the TechSmith website by clickingCompany >
Contact Us. Always refer to that location for latest, most accurate information.

Phone: +1.517.381.2300 (ext. 784)

Toll Free in the U.S. & Canada: +1.800.517.3001 (ext. 784)

Tech Support Website: http://support.techsmith.com

How to Export Event Viewer Logs
The following information explains how to export the event viewer logs for the components of TechSmith
Relay.

If the TechSmith node is not present on a server where TechSmith Relay Server has been
installed, this means that the Relay Manager Service never started on that server. If the server
isn’t running and you there isn’t a TechSmith node in the Event Viewer, try the Restart
TechSmith Relay Server shortcut on the desktop, it may solve the problem.

TechSmith Relay Recorder

Windows XP

1. Go toStart > Run > eventvwr.
2. Right-click TechSmith and select Save Log Files As.
3. Save the log in the EVT format.
4. Right-click Application and select Save Log Files As.
5. Save the log in the EVT format.
6. Right-click System and select Save Log Files As.
7. Save the log in the EVT format.

Windows Vista and Windows 7

1. Open the Start menu and in the search box, type “event viewer” and press Enter.
2. When the Event Viewer opens, expandApplications and Services Logs.
3. Right-click TechSmith and select Save Events As.
4. Save the log in the EVTX format.
5. ExpandWindows Logs.
6. Right-click Application and select Save Events As.
7. Save the log in the EVTX format.
8. ExpandWindows Logs.

http://support.techsmith.com/
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9. Right-click System and select Save Events As.
10. Save the log in the EVTX format.

Windows 8

1. Open the Start menu and search for “event viewer.”
2. Click Settings. On the left, click Event Viewer.
3. When the Event Viewer opens, expandApplications and Services Logs.
4. Right-click TechSmith and select Save Events As.
5. Save the log in the EVTX format.
6. ExpandWindows Logs.
7. Right-click Application and select Save Events As.
8. Save the log in the EVTX format.
9. ExpandWindows Logs.
10. Right-click System and select Save Events As.
11. Save the log in the EVTX format.

Mac OS X

1. i. Open Finder and go to /Library/Logs/TechSmith/.
2. ii. Right-click TechSmith Relay and select Compress TechSmith Relay to create a ZIP file of the

log files on the desktop.

TechSmith Relay Server

Windows Server 2003

1. Go toStart > Administrative Tools > Event Viewer.
2. Right click TechSmith and select Save Log Files As.
3. Save the log in the EVT format.
4. Right-click TechSmith and select Save Log Files As.
5. Save the log in the EVT format.
6. Right-click Application and select Save Log Files As.
7. Save the log in the EVT format.
8. Right-click System and select Save Log Files As.
9. Save the log in the EVT format.

Windows Server 2008 and Greater

1. Open theStartmenu and in the search box, type “event viewer” and press Enter.
2. When the Event Viewer opens, expandApplications and Services Logs.
3. Right-click TechSmith and select Save Events As.
4. Save the log in the EVTX format.
5. ExpandWindows Logs.
6. Right-click Application and select Save Events As.
7. Save the log in the EVTX format.
8. ExpandWindows Logs.



www.techsmith.com - 108 -

9. Right-click System and select Save Events As.
10. Save the log in the EVTX format.
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All rights reserved

This manual, as well as the software described in it, is furnished under license andmay be used or copied only
in accordance with the terms of such license. The content of this manual is furnished for informational use
only, is subject to change without notice and should not be construed as a commitment by TechSmith Cor-
poration. TechSmith Corporation assumes no responsibility or liability for any errors or inaccuracies that may
appear in this manual.

Trademarks

All-in-One Capture, Camtasia, Camtasia Relay, Camtasia Studio, Coach's Eye, DubIt, EnSharpen, Enter-
priseWide, Expressshow, Jing, Morae, Rich Recording Technology (RRT), Screencast.com, ScreenChomp,
Show TheWorld, SmartFocus, Snagit, TechSmith, TechSmith Fuse, TSCC and UserVue are either
registeredmarks or marks of TechSmith Corporation in the U.S. and/or other countries. This list is not a com-
prehensive list of all TechSmith Corporationmarks. The absence of a name/mark or logo in this notice does
not constitute a waiver of any intellectual property rights that TechSmith Corporation has established in any of
its product, feature or service names/marks or logos. All other marks are the property of their respective own-
ers.
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Introduction
With TechSmith Relay, capture and publish your lecture or presentation anytime, anywhere--in the classroom,
in the conference room, at your desk, or at home. TechSmith Relay supports a wide variety of media formats
onmultiple playback devices including portable media devices such as the Apple iPod and via iTunes U.

There are two parts to TechSmith Relay--the recorder which runs on your computer and the server which pro-
cesses and publishes all presentations.
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Important TechSmith Relay Concepts
Before you start using TechSmith Relay, there are several concepts you should be familiar with. Please
review the following topics.

The TechSmith Relay Recorder
To record a presentation, you first need to download and install the TechSmith Relay recorder on your com-
puter. Click Download Recorders and then click the recorder download link for your operating system to
start the download.

The portable recorder can be installed on amobile storage device, such as a USB flash drive. This recorder
provides you with an option for recording when you:

Do not have permission to install applications.

Have limited or no network access.

Have several presentations and want to upload them collectively at a later time.

Depending on your organization, the portable recorder may or may not be available. Contact
your administrator for more information.

For more information on the recorder, seeDownload Recorders.

Profiles
Profiles are the backbone of TechSmith Relay. They allow presenters to record without having tomake any
decisions about how the presentations are processed or where they are placed for viewing.

Profiles are created by the administrator and include settings that define how the presentation is recorded, pro-
cessed, and published. When selecting a profile in the TechSmith Relay Recorder, only the profile title is avail-
able to help presenters choose which one to use; the profile description is only visible on the website.

TheUpload and Decide Later Profile sends the recording to the TechSmith Relay server but does not process
the recording in any way. The presentation stays in theNeeds Attention state on the server until an admin-
istrator or the presenter selects a profile to use or deletes the presentation.

For more information, seeProfiles.

Accounts
After presentations are processed, they are sent to publish destinations for viewing. Publish destinations
include locations like iTunes, a Screencast.com account, a file server, etc. In many cases, account cre-
dentials are required to access publish destinations.

There are two ways that TechSmith Relay can handle credentials. Credentials can be supplied by an admin-
istrator, or a presenter may be required to enter his or her own account credentials.

In the case where a presenter is required to enter credentials, he or shemust log into the TechSmith Relay
website and add a publish account for a given publish destination.

Presentations submitted using a profile that needs a presenter to add a publish account are held in theNeeds
Attention state until a valid publish account is added.
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For more information on how to add a publish account, seePublish Account Setup.

See also

Introduction

Account Settings

Help and Resources

Presentations

Caption Editor

Profiles

Profile Setup

Publish Account Setup

Download Recorders

TechSmith Relay Portable Recorder
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Account Settings
Depending on how your TechSmith Relay administrator sets up TechSmith Relay, youmay need or want to
modify your TechSmith Relay account.

Presenters may not have the ability to modify their TechSmith Relay account information in
some cases. For example, if presenter login information in TechSmith Relay is bound to net-
work credentials presenters cannot edit username and password on the TechSmith Relay web-
site.

On the Change Account Information tab, presenters can access the following fields:

The Name field changes the name used in presentation notifications.

The Email Address field changes the email address to which email notifications, such as completed
presentations, are sent.

If the Change Password tab is available, presenters can change the password they use to log into the
TechSmith Relay website and recorder.

See also

Introduction

Important TechSmith Relay Concepts

Help and Resources

Presentations

Caption Editor

Profiles

Profile Setup

Publish Account Setup

Download Recorders

TechSmith Relay Portable Recorder
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Presentations
The Presentations page allows you to view presentations by state and take action to resolve issues.

Presentations in all states have the following information:

User name and email of presenter that submitted the presentation

Date and time the presentation was recorded

Presentation description, if entered by the presenter

Profile used, with link to view and edit profile

Duration of presentation

Resolution of presentation

You can view presentations on the server by the following states:

States Description

Needs
Attention

Use the information and options provided to resolve issues so the presentation
can process. Includes a list of presenters and a list of profiles to select from. You
can also delete presentations.

Processing
View the progress of a processing presentation. You can see the progress of
each job associated with the presentation, including transcription, encoding, pub-
lishing, and notifications.

Uploading View the upload progress and cancel upload, if needed.

Completed

View the status of presentations that have completed processing. For some pub-
lish destinations, links are included to view the published presentation. Select
Remove from List to permanently remove a presentation from the Completed
list.

Deleted View information about any deleted presentations.

Failed Use the information provided to figure out why a presentation failed. Includes
status information to show you which part of processing failed.

Held for
Captioning

View the presentations held for caption editing. When caption editing is complete
or to skip caption editing, click Edit Captions to open the presentation in the cap-
tion editor orRelease Hold to continue processing the presentation.

See also

Introduction

Important TechSmith Relay Concepts

Account Settings
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Help and Resources

Caption Editor

Profiles

Profile Setup

Publish Account Setup

Download Recorders

TechSmith Relay Portable Recorder
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Caption Editor
The Caption Editor page allows presenters and global caption editors to review and edit captions that were cre-
ated automatically by TechSmith Relay. When a presentation is held for caption editing, all processing and
publishing is stopped until the presenter releases the presentation to complete processing and publishing.

Users can only access the Caption Editor page if they have a presentation that is being held for caption edit-
ing.

Microsoft Silverlight is required to edit captions. The website prompts you if installation of or an
update to Silverlight is required.

See also

Access the Caption Editor

Edit Presentation Captions

Caption Editing Tips

Access the Caption Editor
When a presenter has uploadedmedia that is ready for captioning, there are a few ways to get to the caption
editor. Global caption editors have access to a third option, the Presentations page.
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From aNotification Email.

Click theEdit the presentation captions link in the email you receive when a presentation is ready for
caption editing.

From the TechSmith Relay Website Dashboard
Click the name of a presentation shown under Presentations held for caption editing.

From the Presentation List on the TechSmith Relay Website.

Select Held For Captioning from the Status dropdown list.

Click a presentation to select it.

On the right side of the page, click Edit Captions.

See also

Edit Presentation Captions

Caption Editing Tips

Edit Presentation Captions
Once a presentation is open on the Caption Editor page, use the following process for editing captions and sub-
mitting the presentation for final processing and publishing:

1. On the Edit Captions tab, use the video controls review the automatic captions.

2. Edit existing captions by clicking inside a caption and editing the text.

3. Add , delete , and split captions as needed using the controls.
4. To save your work, click Save.

TechSmith Relay automatically saves changes to the presentation captions every
minute.
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5. When the captions are complete, click the Preview and Submit tab.

6. Review the presentation andmake any final adjustments to the text or timing of the captions.

7. When you are satisfied with the captions, click Publish.

The presentation continues processing and publishing.

See also

Access the Caption Editor

Caption Editing Tips

Caption Editing Tips
Here are some tips to help you when editing captions:
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To stop at the end of each caption, disable the Continuous Playback button .

While working in a caption, click Replay to repeat the text of the selected caption once. Repeatedly
click theReplay button until you are able to transcribe the entire caption.

The number in the lower right of a caption shows the remaining characters available to keep the caption
within compliancy guidelines. If a caption is too long, it turns yellow and shows a negative number of
characters available.

Click theSplit button to separate a caption into two smaller captions.

Use the standard keyboard shortcuts for Undo (CTRL+Z, Command+Z) and Redo (CTRL+Y, Com-
mand+Y) to undo or redo your actions in the caption editor.

See also

Access the Caption Editor

Edit Presentation Captions
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Profiles
A profile consists of settings that determine how a presentation is recorded, processed, and presented. Pro-
files are created by the TechSmith Relay administrator. If you do not have a profile that provides you with the
options that you need, seeCan I Change My Profiles?

To access information on profiles available to you:

1. Log in to the TechSmith Relay website.
2. Click Profiles
3. In the list of profiles, click a profile.
4. Click Overview. SeeProfile Setup for additional information.

Only TechSmith Relay administrators can create or modify profiles.

If you are not satisfied with existing profile options, you can select the Upload and Decide
Later Profile. This sends the recording to the server where it remains until you contact your
TechSmith Relay administrator to create or modify a profile.

Can I Change My Profiles?
Only TechSmith Relay administrators can create or modify profiles. If you are not satisfied with your existing
profile options, contact your TechSmith Relay administrator. Consider the following questions before con-
tacting your administrator.

What kind of recording do you want to make:
Will there be a lot of movement, such as video, in your presentations?

Are you going to record PowerPoint presentations?

Anything else the administrator should know about what you are recording?

Are you planning on editing presentations in Camtasia Studio?

What kind of files do you want to produce:
Do you needmultiple file types for the same presentation?

Is there a certain kind of file you need?

Do you want an audio-only file?

Should the produced presentations be certain dimensions?

Where do you want the produced files to end up:
Do you have a file folder location for the produced files?

Do you have an account on Screencast.com that you want to use?
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Do you want to send your presentations to a website via an FTP server?

Do you want to send your presentations to iTunes U?

Some of the options mentioned abovemay not be available for your use.

See also

Introduction

Important TechSmith Relay Concepts

Account Settings

Help and Resources

Presentations

Caption Editor

Profile Setup

Publish Account Setup

Download Recorders

TechSmith Relay Portable Recorder
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Profile Setup
On the Profile Setup page for a profile, presenters can select publish accounts to use for the profile and
access an overview of a profile.

Publish Accounts
Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

Select a publish account for each encode setting or select one publish account to use for all encodings within
a publish destination.

Profile Overview

Settings included in a profile:

Description:What should you use this profile for? The description is entered by an
administrator to help you to choose the correct profile for your needs.

Publish destinations:Where the produced files go. Presentations can be pub-
lished to one or more destinations. Examples include an FTP server, a network
drive, Screencast.com, or iTunes U.
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Encode settings:What kinds of files are produced. The original recording is
encoded into one or more formats. Examples include an audio only (MP3) encoding,
an iPod-compatible encoding, orWindows Media format. Encoding can reduce the
frame rate and audio quality, but can never improve the original recording.

Publish accounts:How to access the publish destinations. These accounts con-
tain specific information used to place processed presentations in a publish des-
tination, such as authentication information, folder selection, etc.

Notifications:How people are informed when presentations are published. Noti-
fications are sent per profile and can include information about multiple encodings of
the same presentation.

See also

Introduction

Important TechSmith Relay Concepts

Account Settings

Help and Resources

Presentations

Caption Editor

Profiles

Publish Account Setup

Download Recorders

TechSmith Relay Portable Recorder
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Publish Account Setup
On the Publish Account Setup page for a profile, presenters can select publish accounts to use for the profile
and access an overview of a profile.

For each available publish destination, you can define the accounts for TechSmith Relay to use to access it.

Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

To Create a Publish Account
1. On the Publish Account page (Profiles > Publish Accounts Setup), click one of the publish des-

tinations you have set up.
2. Enter information for the new account.
3. Select if you want to make the account the default account. See the tips below for information about

default accounts.
4. If not a default account, select if you want toUse account information from default account. This

allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

5. Click Save.

Things to Consider About Publish Accounts
The following informationmight help you inmaking some decisions when creating your publish accounts.

Each publish destination can have a default account.

This can be helpful in several ways:

You can set up a default account to hold the credentials used to access a publish destination,
and then use the other accounts to place presentations into various folders.
When you select a publish destination and encode setting in a profile, the default account is
selected automatically for the publish account.

You can select different publish accounts for each publish destination/encode setting combination in a
profile.

YouTube publish accounts require verification to upload videos longer than the YouTubemax-
imum (15minutes as of November 2011). For more information on verifying your YouTube
account, visit YouTube.com.

See also

Introduction

Important TechSmith Relay Concepts

Account Settings

Help and Resources

http://www.youtube.com/
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Download Recorders
On the Download Recorders page, presenters can access and download the TechSmith Relay Recorders.

As of version 4.1, when a new version of the TechSmith Relay server is installed, an update notification is
sent to TechSmith Relay Recorder clients informing users of the availability of an update. Recorders down-
loaded from versions of TechSmith Relay prior to 4.1 receive no update notifications.

When presenters download the recorder, any available plug-ins and add-ins are also installed on the
presenters’ computers.

Windows Operating Systems
Presenters are given the option in the TechSmith Relay recorder installer to install the
TechSmith Relay Add-In for Microsoft Office PowerPoint. This add-in allows a presenter to
easily record a PowerPoint slide show with TechSmith Relay from inside of PowerPoint. See
the TechSmith Relay recorder help for more information.
Presenters that are also running Camtasia Studio 5.1 and above are provided with a plug-in that
allows for sending a Camtasia Studio project to the TechSmith Relay server for production and
publishing. An option to produce with TechSmith Relay is added to the production process in
Camtasia Studio automatically when both programs are installed on the same computer.

Mac Operating Systems

Presenters that are also running Camtasia for Mac 1.2 and above are provided with a plug-in that
allows for sending a Camtasia for Mac project to the TechSmith Relay server for production and pub-
lishing. An option to share with TechSmith Relay is added to Camtasia for Mac automatically when
both programs are installed on the same computer.

TechSmith Fuse®

In addition to recording a computer screen, live video footage taken with amobile device recorded with
TechSmith Fuse can be sent to a TechSmith Relay server.

Existing videos on your mobile device can also be uploaded via TechSmith Fuse.

TechSmith Fuse is available for iOS, Android, andWindows devices.

See also

TechSmith Relay Portable Recorder

Introduction

Important TechSmith Relay Concepts

Account Settings

Help and Resources

Presentations
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Profiles
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Profile Setup

Publish Account Setup

Download the Portable Recorder
If you need a portable version of TechSmith Relay, use the following process to install the portable recorder on
amobile storage device, such as a USB flash drive.

1. Plug in amobile storage device and format the device as FAT32.
2. If available on the Download Recorders page, click Download Portable Recorder and save the ZIP

file to your computer.

Youmay have to request the portable recorder. Click the button to send a request to your administrator.

3. Locate and open PortableTechSmithRelay.zip.
4. Copy all files from the ZIP file onto themobile storage device. All files from the ZIP folder need to be

copied to the root of the device.

Depending on your organization, the portable recorder may or may not be available. Contact
your administrator for more information.

See also

TechSmith Relay Portable Recorder

Run the Portable Recorder

Log In to the Portable Recorder

Record with the Portable Recorder

Upload Presentations from the Portable Recorder

Log In to the Portable Recorder
There are some considerations to keep inmind when you attempt to log in to the TechSmith Relay portable
recorder.

To log in on the portable recorder, youmust first run the portable recorder on a computer that can con-
nect to the TechSmith Relay server.

To do this, connect themobile storage device to a computer with the "regular" TechSmith Relay
recorder installed on it. Open the portable recorder and log in. This saves your presenter information on
the portable recorder and allows you to access your profiles when you are not connected to the server.

If you run the portable recorder without previously logging in while connected to the server, you are not
able to log in. Identify yourself as a guest to use the Upload and Decide Later profile.
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See also

TechSmith Relay Portable Recorder

Download the Portable Recorder

Run the Portable Recorder

Record with the Portable Recorder

Upload Presentations from the Portable Recorder

Record with the Portable Recorder
Youmay notice a few differences when running TechSmith Relay from amobile storage device, but generally,
the process of recording is the same.

Differences when Recording with Portable Recorder

Click theView Presentations button to see and upload the presentations saved to themobile
storage device.

In most cases, you will not be connected to the server. When you see this icon , you are not con-
nected to the server.
After you finish recording, youmust save your file to themobile storage device running the TechSmith
Relay portable recorder. You cannot submit it for upload from the computer you are using.
Youmay not be able to log in. See Log In to the Portable Recorder for more information.

When you finish your recording, click Save to save the presentation to themobile storage device.

If you are running the portable recorder on a computer with TechSmith Relay installed, you can choose
to save your presentation or submit it for upload to the server.
To upload saved presentations, connect themobile storage device to a computer with TechSmith
Relay installed on it. You can thenUpload Presentations from the Portable Recorder.

See also

TechSmith Relay Portable Recorder

Download the Portable Recorder

Run the Portable Recorder

Log In to the Portable Recorder

Upload Presentations from the Portable Recorder
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Run the Portable Recorder
Depending on the operating system and security settings of a computer, you can start the portable recorder in
one of the following ways.

Windows Operating System with AutoPlay Enabled

Under certain conditions, when you connect amobile storage device that contains the portable recorder with a
computer, you are presented with the option to immediately start the application.

Click Start TechSmith Relay to run the portable recorder.

Windows Operating System with AutoPlay Disabled

If AutoPlay is disabled, to run recorder:

1. OpenWindows Explorer (Right-click Start and select Explore.)
2. Navigate to themobile storage device.
3. Double-click PC TechSmith Relay.exe.

Mac Operating System

1. Navigate to themobile storage device.
2. Double-click Mac TechSmith Relay.

See also

TechSmith Relay Portable Recorder

Download the Portable Recorder

Log In to the Portable Recorder

Record with the Portable Recorder

Upload Presentations from the Portable Recorder

TechSmith Relay Portable Recorder
Download and use the TechSmith Relay portable recorder if there is any reason you cannot (or should not)
record and upload directly from the presentation computer.

Examples of When to Use the Portable Recorder

You need to record on a computer where you do not have permission to install applications.

You need to record on a computer with limited or no network access.

You want to record several presentations and upload them collectively at a later time.

Depending on your organization, the portable recorder may or may not be available. Contact
your administrator for more information.
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See also

Download the Portable Recorder

Run the Portable Recorder

Log In to the Portable Recorder

Record with the Portable Recorder

Upload Presentations from the Portable Recorder

Upload Presentations from the Portable Recorder
To upload saved presentations from amobile storage device, youmust connect themobile storage device to a
computer with TechSmith Relay Recorder installed on it.

You can submit saved presentations at any time. If you are not connected to the Internet, the
presentations upload to the server when your computer is next connected.

To submit saved presentations for upload:

1. Click theView Saved Presentations button. The Saved Presentations dialog opens.

2. Click Submit All to submit all of the presentations for upload or click to submit individual present-
ations.

If you are online and connected to the server, your presentation starts to upload.

If you are offline, your presentation is stored on the computer and automatically upload to the
server once you are online and connected.

See also

TechSmith Relay Portable Recorder

Download the Portable Recorder

Run the Portable Recorder

Log In to the Portable Recorder

Record with the Portable Recorder
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Help and Resources
The Help and Resources page assists presenters in answering questions or finding help for the TechSmith
Relay website.

Here presenters can view training videos, access frequently asked questions and answers, and link directly to
the Download Recorders page.
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Introduction
This document introduces you to the TechSmith Relay caption editing process for global caption editors. A
global caption editor has access to all the presentations in queue that require captioning

For more information, see The Global Caption Editor Role

TechSmith Relay Administration Help Topics

The Global Caption Editor Role

Caption Editor

Access the Caption Editor

Edit Presentation Captions

Caption Editing Tips

Help and Resources
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The Global Caption Editor Role
A global caption editor role is a user who has access to the TechSmith Relay website, but is unable to record
presentations. The global caption editor has access to all presentations that are held for captioning on the
TechSmith Relay server.

When a user who has been assigned to the role of global caption editor logs in to the TechSmith Relay web-
site, a list of presentations currently held for captioning is displayed.

Multiple global caption editors cannot caption the same presentation at the same time. If a
global caption editor opens a presentation that is currently being captioned by another user, the
changes made by the first user to open the presentation for captioning are lost.

Global caption editors can receive daily email notifications that list presentations currently held for captioning
on the TechSmith Relay server.

See also:

Caption Editor

Access the Caption Editor

Edit Presentation Captions

Caption Editing Tips
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Caption Editor
The Caption Editor page allows presenters and global caption editors to review and edit captions that were cre-
ated automatically by TechSmith Relay. When a presentation is held for caption editing, all processing and
publishing is stopped until the presenter releases the presentation to complete processing and publishing.

Users can only access the Caption Editor page if they have a presentation that is being held for caption edit-
ing.

Microsoft Silverlight is required to edit captions. The website prompts you if installation of or an
update to Silverlight is required.

See also

Access the Caption Editor

Edit Presentation Captions

Caption Editing Tips

Access the Caption Editor
When a presenter has uploadedmedia that is ready for captioning, there are a few ways to get to the caption
editor. Global caption editors have access to a third option, the Presentations page.
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From aNotification Email.

Click theEdit the presentation captions link in the email you receive when a presentation is ready for
caption editing.

From the TechSmith Relay Website Dashboard
Click the name of a presentation shown under Presentations held for caption editing.

From the Presentation List on the TechSmith Relay Website.

Select Held For Captioning from the Status dropdown list.

Click a presentation to select it.

On the right side of the page, click Edit Captions.

See also

Edit Presentation Captions

Caption Editing Tips

Edit Presentation Captions
Once a presentation is open on the Caption Editor page, use the following process for editing captions and sub-
mitting the presentation for final processing and publishing:

1. On the Edit Captions tab, use the video controls review the automatic captions.

2. Edit existing captions by clicking inside a caption and editing the text.

3. Add , delete , and split captions as needed using the controls.
4. To save your work, click Save.

TechSmith Relay automatically saves changes to the presentation captions every
minute.
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5. When the captions are complete, click the Preview and Submit tab.

6. Review the presentation andmake any final adjustments to the text or timing of the captions.

7. When you are satisfied with the captions, click Publish.

The presentation continues processing and publishing.

See also

Access the Caption Editor

Caption Editing Tips

Caption Editing Tips
Here are some tips to help you when editing captions:
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To stop at the end of each caption, disable the Continuous Playback button .

While working in a caption, click Replay to repeat the text of the selected caption once. Repeatedly
click theReplay button until you are able to transcribe the entire caption.

The number in the lower right of a caption shows the remaining characters available to keep the caption
within compliancy guidelines. If a caption is too long, it turns yellow and shows a negative number of
characters available.

Click theSplit button to separate a caption into two smaller captions.

Use the standard keyboard shortcuts for Undo (CTRL+Z, Command+Z) and Redo (CTRL+Y, Com-
mand+Y) to undo or redo your actions in the caption editor.

See also

Access the Caption Editor

Edit Presentation Captions



www.techsmith.com - 7 -

Help and Resources
The Help and Resources page assists presenters in answering questions or finding help for the TechSmith
Relay website.

Here presenters can view training videos, access frequently asked questions and answers, and link directly to
the Download Recorders page.
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All rights reserved

This manual, as well as the software described in it, is furnished under license andmay be used or copied only
in accordance with the terms of such license. The content of this manual is furnished for informational use
only, is subject to change without notice and should not be construed as a commitment by TechSmith Cor-
poration. TechSmith Corporation assumes no responsibility or liability for any errors or inaccuracies that may
appear in this manual.

Trademarks

All-in-One Capture, Camtasia, Camtasia Relay, Camtasia Studio, Coach's Eye, DubIt, EnSharpen, Enter-
priseWide, Expressshow, Jing, Morae, Rich Recording Technology (RRT), Screencast.com, ScreenChomp,
Show TheWorld, SmartFocus, Snagit, TechSmith, TechSmith Fuse, TSCC and UserVue are either
registeredmarks or marks of TechSmith Corporation in the U.S. and/or other countries. This list is not a com-
prehensive list of all TechSmith Corporationmarks. The absence of a name/mark or logo in this notice does
not constitute a waiver of any intellectual property rights that TechSmith Corporation has established in any of
its product, feature or service names/marks or logos. All other marks are the property of their respective own-
ers.
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TechSmith Relay Overview

TechSmith Relay is an end-to-endmedia hosting solution that offers simple recording onmultiple devices and
secure hosting for your shared content.

TechSmith Relay Recorder is just one of the components in the overall TechSmith Relay solution. This
desktop recorder is what records and sends media to your secure hosting site. With TechSmith Relay
Recorder, capture and publish anytime, anywhere -- in the classroom, in the conference room, at your desk, or
at home. TechSmith Relay supports a wide variety of file formats, allowing any lecture or presentation to be
viewed by your audience onmultiple devices.

See also

Log In to TechSmith Relay Recorder

Make a Video Recording

NeedMore Help?
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TechSmith Relay Recorder Overview
With TechSmith Relay Recorder, capture and publish a recording anytime, anywhere -- in the classroom, in
the conference room, at your desk, or at home. TechSmith Relay supports a wide variety of video formats
allowing any lecture or presentation to be viewed by your audience onmultiple playback devices.

There are two parts to TechSmith Relay--the recorder, which runs on your computer or mobile device, and the
website, which hosts all your video recordings. In this help file, you will find topics specific to the TechSmith
Relay Recorder.

See also

Make a Video Recording

Record a PowerPoint Presentation

Log In to TechSmith Relay Recorder

After Recording

The TechSmith Relay Website

UploadMedia

FAQs
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Log In to TechSmith Relay Recorder
When you open TechSmith Relay Recorder, it prompts you to log in using your TechSmith Relay credentials.

If you choose not to log in when prompted, you can log in before or after recording using the Log In button.

Why log in?

Do I have to log in before recording?

I don’t know my username or password. What should I do?
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Why Log In?

Youmust log in as a presenter before you can submit or save your presentation.

When you log in to TechSmith Relay Recorder, you do the following:

Identify yourself as a presenter

Log in to gain access to your profiles and identify yourself as the presenter. You can log in before or
after recording.

Save settings

When you select an audio device or set hotkeys while logged in, the audio device and hotkeys are
stored and available the next time you log in.

If you enable theRemember Me option, you do not see the TechSmith Relay Login dialog box
each time you open the TechSmith Relay Recorder. All of your settings are saved and you can
immediately access your profiles. Depending on the administrator’s choice of security set-
tings, Remember Memay occasionally be reset. You just need to log in again and enable
Remember Me.

See also

Do I Have to Log in Before Recording?

Having Problems with Your Username or Password?
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Do I Have to Log in Before Recording?
Running late for your presentation? Can’t remember your password?

For these and other reasons, you are not required to log in before recording.

Although you can record without logging in, youmust log in before you can submit media. If
you try to submit or savemedia without logging in, you are prompted to do so.

See also

Log In to TechSmith Relay Recorder

Having Problems with Your Username or Password?
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Having Problems with Your Username or
Password?
Here are a few things to try if you're having problems logging in to TechSmith Relay Recorder:

If you were not given a username or password, you can try logging in with your network username and
password. Some organizations set up TechSmith Relay to use these network credentials.
In the TechSmith Relay Recorder login dialog, click Forgot password.

If you can’t remember your username or password and none of the above work for you, contact your
TechSmith Relay administrator.

See also

Log In to TechSmith Relay Recorder

Why Log In?
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Upload Media
If you have existingmedia files that you want to share to TechSmith Relay, you can do that using the Upload
Media function.

The following file types are supported for upload:

Video: MOV, MP4

Image: PNG, JPEG, JPG, GIF

Note: Your assigned profiles may limit what media types you are permitted to upload. If you have questions
about uploadingmedia, contact your TechSmith Relay administrator.

To upload media:
1. Log in to the TechSmith Relay Recorder and select Upload.
2. Click the AddMedia button and select your files for upload.

To uploadmore than one at a time, hold down the Control button and select multiple files. With your
files selected, click Open.Your files will be added to the upload list.

3. Edit the titles and descriptions of your media files if you wish, then click Upload All to share the entire
list to TechSmith Relay.

To share a single file from the list, click the Upload icon to the right of the file information.

To remove an item from the list, click on the X to the far right of the file information.
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Note: It is important to maintain your internet connection while themedia is uploading. If you become dis-
connected while themedia is uploading, the process will pause and resumewhen your connection is rees-
tablished.
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Audio Devices
TechSmith Relay Recorder captures audio from the system as well as a single audio device, such as:

Built-in microphones

Standardmicrophones

USB microphones

Webcams

Device line-in connected to a soundmixer

You cannot change the audio device selection once a recording begins.

Select an Audio Device
1. Connect your audio device to the computer before launching TechSmith Relay Recorder.
2. Launch the TechSmith Relay Recorder and click theAudio button.

The Select Audio Device dialog opens.

The Select Audio Device dialog shows the levels of all audio devices connected to the
computer.

3. Click your audio device to select it.
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4. Click OK to close the dialog.

Record System Audio
To record the audio that plays on your system (the audio that you hear played back by your computer):

1. Click theAudio Device button.

The Select Audio Device dialog opens.

2. Enable the Record System Audio checkbox. (This option is enabled by default.)
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The option to record system audio is not available for users of theMicrosoft Windows
XP operating system.

See also

Auto Adjust Audio Level

Audio Tips
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Auto Adjust Audio Level
If the audio levels are too high when recording, the quality of your processed presentation is poor. Recordings
with poor audio also have a low level of accuracy in captions and full audio search (when transcription is
provided by the profile).

By default, TechSmith Relay Recorder automatically adjusts the input level of the selected audio device to
provide the best possible audio for your presentation. As the volume of the audio changes, the slider moves
automatically to adjust the level of the recorded audio.

There are some cases when youmay want to disable the auto adjust option:

You use a soundmixer to combine and control the levels of multiple devices into a single audio input.

You want moremanual control of your audio input levels.

To disable the auto adjust feature, click theAuto Adjust button.

See also

Audio Devices

Audio Tips
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Audio Tips
Use the following tips to help you get the best audio in your recording.

Verify you are recording the correct audio input.
Make sure you click theAudio Device button, view all available devices while speaking into
your microphone, and click the device based on the input levels. The names of devices can be
deceiving and viewing the levels of all the connected devices helps you choose the correct
device.
Make a test recording. Speak in your presentation voice and volume.

If you are using an external microphone, move away from the computer and speak to ensure
you record the external microphone and not a potential built-in microphone on the computer.
Use theWindows Control Panel to verify desired audio input devices are enabled and working
properly.

Use auto adjust or manually adjust the input level.
If the audio levels are too high and “clip” when recording, the quality of your processed recording is
poor. Recordings with poor audio also have a low level of accuracy in captions and full audio search
(when transcription is provided by the profile.)

If you are not using the option to automatically adjust the audio input levels, make sure to adjust the
audio level appropriately. Speak in your presentation voice and adjust the audio input slider so the indic-
ator peaks near the end of the green bars and is not consistently showing red bars. You can adjust the
audio input level before and after you start recording.

If you see the followingmessage, enable the auto adjust option or move the audio slider
to the left to decrease the input level.

Obtain a good external microphone.
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Some computers have decent built-in microphones. Some do not. It might be worth investing in a USB
or line-in microphone.

Verify audio inputs are enabled.

Click Start > Control Panel > Sound (Sound and Audio Devices on theMicrosoft Windows XP oper-
ating system). Verify that audio inputs are enabled.

If necessary, use a powered audio input.

Some laptops do not have powered audio input ports. This means you need to use a poweredmicro-
phone or a USB microphone.

Make a test recording to check system audio levels.

If you plan on recording system audio, check tomake sure it is recording at an appropriate volume
level. For instance, if you plan on playingmusic during your recording, play that music during your test
recording. The volume level of system audio is recorded before volume adjustments from your laptop or
the room's audio system affect the signal, so the volume heard from your speakers or the room's sound
systemmay not match the volume of the system audio in the recording.

If you lose audio during a recording, a notification appears on screen

If the batteries in your microphone die, or themicrophone becomes unplugged, a warning notification
will appear to let you know that the TechSmith Relay Recorder is no longer recording audio.

See also

Audio Devices

Auto Adjust Audio Level
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Record with a Camera
Before recording, select a camera to record with your presentation. The camera video appears in the lower
right corner of your produced presentation. During your presentation, the camera is not displayed on your
screen.

Currently, there are no options to change the position or size of the picture-in-picture camera video.

Camera video is only included in profiles that use encode settings for the TechSmith Smart
Player.

TechSmith Relay Recorder only supports recording video from webcam-type cameras. It does
not support DV camera input.

Select a Camera
To select a camera to record with your presentations:

1. Click theCamera button in the recorder toolbar.

2. The camera selection window appears. Select from available cameras to record that camera video with
your presentation. Select "Do not record camera" to turn off camera video recording.
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If another application is using the camera, TechSmith Relay Recorder may be unable to
record.
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Hotkeys
In TechSmith Relay Recorder, hotkeys are for more than just convenience.

While they do save time, they also allow you to start, pause, and stop your recording without the audience see-
ing TechSmith Relay Recorder during the presentation.

To set hotkeys:

1. ChooseHotkeys.

2. Select a key combination for each hotkey.

3. Click OK.

See also

Audio Devices

More ThanOneDisplay

Record with a Camera

Available Disk Space
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More Than One Display
TechSmith Relay Recorder records one entire display. If your computer has multiple monitors or is connected
to a projector, you need to specify which display to record.

TechSmith Relay Recorder displays a small window on the display not selected for recording.
You can leave this up to help show how long you’ve been recording, or if you prefer, minimize it
to the taskbar.

To select a display:

1. Click in theRecording Preview.

Depending on whether you have previously selected a display, you will see either a
message to select a display or the currently selected display.

2. When you see the display selector, click the display you want to record.

As you hover over a display in the selector, there is a red outline shown on the actual
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display to help you identify the different displays.

If you click the Test button or the Record button prior to selecting a display to record, you are
prompted tomake a selection before recording starts.

When using PowerPoint with multiple monitors or a projector, make a test recording while run-
ning the presentation as a slide show to verify you record the correct screen. PowerPoint set-
tingmay affect which display slide shows appear on.
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Make a Video Recording
Learn how tomake a recording and submit it to TechSmith Relay.

If you are recording aMicrosoft Office PowerPoint presentation, you can use the TechSmith Relay Recorder
Add-In for PowerPoint.

1. Launch TechSmith Relay Recorder.
2. Log in with your username and password.

3. Click theAudio button and select an audio device in the Select Audio Device dialog.

Select Record System Audio to include the sound you hear from your speakers in the recording.

4. Select which display to record if using a projector displaying a different screen or multiple displays.
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5. Click theCamera button to select a camera to record along with your video. This camera is displayed
in the lower right corner of your video in a picture-in-picture format.

6. Enter a video title and description.

7. Make a test recording to verify that you are recording from the correct display, camera, and audio
device.
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8. Click the Record button. The recorder is minimized to the system tray.

9. Complete your presentation or screen recording. TechSmith Relay Recorder records everything on
your screen, selected camera, and the selected audio device.

10. Stop the recording using a hotkey or right-click the icon in the system tray. Theremay be a delay as the
recording is finalized. The recording opens in the TechSmith Relay Recorder review window.

11. If needed, click Trimming to set trim points to cut out extra video at the beginning and end of the record-
ing.

12. Click theSubmit button.

If you are connected to the Internet, the recording starts uploading to the TechSmith Relay web-
site.

If you are not connected to the Internet, the recording automatically starts uploading when you
connect to the Internet. You do not receive notice when your recording begins uploading.

After you submit a recording for upload, you cannot access it or view its status on your
computer. Instead, you can Check the Status of SubmittedMedia on the TechSmith
Relay website.
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Make a Test Recording
Few things are worse than recording an important presentation only to find out later there was no audio or you
were recording the wrong screen. It is important to make a test recording—especially when new to TechSmith
Relay Recorder.

Tomake a test recording:

1. Prepare your computer exactly as if you were presenting:
If you will use a projector, connect the projector.

If using a specific microphone, make sure it is connected and selected.

2. Click the blue Test button to initiate a 10-second test recording.

During the test recording, speak in your presentation voice and launch your PowerPoint or Keynote
presentation, or whatever will be on your screen during your recording.

3. At the conclusion of the test recording, the video opens in a review window.

Click thePlay button to review the recording. Verify the audio is acceptable and the correct screen con-
tent was recorded. Adjust as necessary.

4. Click Close.

See also

Audio Devices

More ThanOneDisplay

Record with a Camera

Available Disk Space
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Available Disk Space
While recording, at the bottom of the TechSmith Relay Recorder is a disk spacemonitor. This monitor shows
how much disk space is available to record.

If you run out of space during a recording, the recording is paused. You canmakemore room on the computer
by removing other files.

To avoid interrupting you during a recording, you are not notified when a recording is paused
due to low disk space.
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After Recording
After you finish recording, the video is finalized and opens in the TechSmith Relay Review window. Here, you
can Trim the Presentation and Preview and Submit Your Presentation.

See also

What Happens After I Submit Media?

Check the Status of Your Media
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Preview and Submit Your Presentation
After you finish recording your presentation, it opens in the TechSmith Relay Review window.

1. Preview your recording by clicking the play button.
2. If you did not do so prior to recording, log in and enter a title and description.
3. If you wish, trim the beginning and end of the recording.
4. When you are ready to submit your presentation, click Submit. If you do not wish to upload the present-

ation, click Discard.
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Trim the Presentation
With TechSmith Relay Recorder, you can edit your presentation to remove extra video at the beginning or
end. Trim your presentation to remove any extra audio and video you do not want in your published present-
ation.

To trim a presentation:

1. After you finish recording, click Trimming to access the trimming tools.

2. Move the playhead to the location you want to set as the beginning of the presentation and click theSet
presentation start button.

3. Move the playhead to the location you want to set as the end of the presentation and click theSet
presentation end button.

The red area of the timeline is cut from the presentation. Once you submit or save the recording, you
permanently lose this part of the recording.

If you want to remove the trim points, click Cancel trim (the red X button.) This removes
the trim points and closes the trimming tools.

See also

Preview and Submit Your Presentation

What Happens After I Submit Media?

Check the Status of Your Media



www.techsmith.com - 31 -

What Happens After I Submit Media?
After you click Submit, your presentation is uploaded to the website.

If you are connected to the Internet, the recording starts uploading immediately. You receive an email
when your video is published.
If you are not connected to the Internet, the recording automatically starts uploading when you connect
to the Internet. You do not receive notice when your recording begins uploading.

You can Check the Status of Your Media on the TechSmith Relay website. You also receive an email when
your presentation is produced and published.

After you submit your video, you cannot access or view your video or the status of the upload
in the TechSmith Relay Recorder.

If your connection is lost while the presentation is uploading, the process is paused and con-
tinues when the computer next connects to the Internet.

See also
Preview and Submit Your Presentation

Trim the Presentation

Check the Status of Your Media
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Check the Status of Your Media
The easiest way to learn the status of your uploadedmedia is to log in to the TechSmith Relay website.

To check the status of your uploaded media
1. Go to the TechSmith Relay website.

2. Log in to the website using your username and password. From the website you'll be able to view your
recently uploadedmedia and see its status.

See also

Preview and Submit Your Presentation

Trim the Presentation

What Happens After I Submit Media?
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Record a PowerPoint Presentation
To record aMicrosoft PowerPoint Presentation with the TechSmith Relay Add-In:

1. Open PowerPoint.

After you install TechSmith Relay Recorder, it automatically prompts you to record
when you start a PowerPoint slide show. You can change this and other default set-
tings in the recording options.

2. Start a slideshow.

A prompt asks if you want to record.

3. Verify the audio selection and level.
4. Click Record Slide Show.

5. Give your presentation as normal.

When you finish the slide show, you can end the recording or continue recording.

6. When prompted, click Stop Recording to end the presentation.

7. The recording is shown in the TechSmith Relay Recorder Review dialog. You can review, trim, edit
details, log in (if needed), and submit your recording for processing. See After Recording for more
information.

See also

TechSmith Relay Add-In Toolbar

TechSmith Relay Add-In Recording Options
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TechSmith Relay Add-In Toolbar
Use the add-in toolbar in PowerPoint to adjust the available options.

With auto record toggled on, TechSmith Relay will prompt you to start recording whenever and
however you start a presentation.

See also

Record a PowerPoint Presentation

TechSmith Relay Add-In Recording Options
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TechSmith Relay Add-In Recording
Options
To change the recording settings in Microsoft PowerPoint, click the Recording options button in the Power-
Point Add-Ins tab.

See also

Record a PowerPoint Presentation

TechSmith Relay Add-In Toolbar
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Update TechSmith Relay Recorder
When a new version of the TechSmith Relay Recorder is available, an update notification appears in the
recorder window.

Update the Recorder
1. Click theUpdate button. (This button only appears when an update for TechSmith Relay Recorder is

available.)

2. Click Get update. This will prompt you to run the update installer.
3. Run the installer.

Check for Updates Manually
1. Open TechSmith Relay Recorder
2. From the Helpmenu, chooseCheck for Updates.
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Need More Help?
In addition to the in-product help files, technical support is available for using TechSmith Relay Recorder. In
the TechSmith Support Center you can search for answers to technical issues and contact support.

http://www.techsmith.com/redirect.asp?target=tssupport&ver=8.1.*&lang=enu&os=win&product=camtasiastudio
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The TechSmith Relay Website
The TechSmith Relay Recorder runs on your computer, and the website, which processes and publishes all
video recordings, is specific to and run by your organization.

Video creators use the same username and password to log in to both the recorder and the website.

If you do not know the URL (web address) of your TechSmith Relay website, contact your administrator.
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FAQs
Have a question about TechSmith Relay Recorder? The following questions and answers might help.

What is TechSmith Relay Recorder?

How do I know that TechSmith Relay Recorder is recording?

Can I edit my recording?

Are there things I should do before I start recording?

I’m not currently online. Do I wait to submit my recording?

Where can I findmore help?

What is the TechSmith Relay Recorder?
TechSmith Relay Recorder lets you easily create a video and audio account of your lecture, presentation, or
meeting. It captures all on-screen activity and audio on computers running on bothWindows andMac oper-
ating systems.

How do I know that the TechSmith Relay Recorder is recording?
There are a couple of visual signals to help you know that TechSmith Relay Recorder is recording:

Can I edit my recording?
The TechSmith Relay recorder supports only trimming the beginning and end of your recording. See Trim the
Presentation for more information.

If you are interested in more serious editing capabilities, Camtasia Studio and Camtasia for Mac can both
share edited videos to TechSmith Relay. This requires access to Camtasia software and approval from your
administrator. Please contact your administrator to find out if this is available in your organization.

Are there things I should do before I start recording?
TechSmith Relay Recorder records everything on your screen and all audio picked up on your selected
microphone. To avoid interruptions during the recording, youmay want to shut down other programs,
such as email, calendar reminders, instant messaging application, etc.
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You should do a test recording to verify TechSmith Relay Recorder is recording what you think it is
recording and that your audio levels are appropriate. SeeMake a Test Recording for more information.
Make sure you have enough disk space for recording. Check your Available Disk Space and remove
any unnecessary files from your computer or portable storage device.

I’m not currently online. Do I wait to submit my recording?
No, you do not need to wait. After you finish recording, you should submit, whether you are online or not.
When you submit, the recording is “readied” for upload. If you are not online, the recording is saved to your
computer and automatically starts uploading the next time your computer is online. It uploads “behind the
scenes” and you will not see any visible cues on your computer. You can Check the Status of Your Media on
the TechSmith Relay website.

Where can I find more help?
For general TechSmith Relay resources from TechSmith, see NeedMore Help?

Please contact your administrator for organization-specific information such as the final location of
your video recordings, login or password issues, microphone issues, etc.
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All rights reserved

This manual, as well as the software described in it, is furnished under license andmay be used or copied only
in accordance with the terms of such license. The content of this manual is furnished for informational use
only, is subject to change without notice and should not be construed as a commitment by TechSmith Cor-
poration. TechSmith Corporation assumes no responsibility or liability for any errors or inaccuracies that may
appear in this manual.

Trademarks

All-in-One Capture, Camtasia, Camtasia Relay, Camtasia Studio, Coach's Eye, DubIt, EnSharpen, Enter-
priseWide, Expressshow, Jing, Morae, Rich Recording Technology (RRT), Screencast.com, ScreenChomp,
Show TheWorld, SmartFocus, Snagit, TechSmith, TechSmith Fuse, TSCC and UserVue are either
registeredmarks or marks of TechSmith Corporation in the U.S. and/or other countries. This list is not a com-
prehensive list of all TechSmith Corporationmarks. The absence of a name/mark or logo in this notice does
not constitute a waiver of any intellectual property rights that TechSmith Corporation has established in any of
its product, feature or service names/marks or logos. All other marks are the property of their respective own-
ers.
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Upgrade to a New Release
This document covers two specific upgrade cases:

Upgrade from 1.x to the Current Version

Upgrade from 2.0 and Later to the Current Version

The installer detects your current setup and will present you with different screens depending on what release
you are upgrading from.

It is strongly recommend that you backup your current database before starting any upgrade.

Installers
TechSmithRelayServer_x64.exe

Use this installer for upgrading TechSmith Relay on a 64-bit server operating system.

If you need additional assistance, you can contact TechSmith Technical Support at http://sup-
port.techsmith.com/. Additional contact information is provided at http://www.techsmith.com/contact.asp.

After you complete an upgrade, youmay want to review the current known issues for
TechSmith Relay 5.0. You can find the list of known issues in the TechSmith Support Center:
https://support.techsmith.com/hc/en-us

TechSmith Relay Recorders
For information about upgrading TechSmith Relay recorders, please see Upgrade Recorders.

http://support.techsmith.com/
http://support.techsmith.com/
http://www.techsmith.com/contact.asp
https://support.techsmith.com/hc/en-us
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Upgrade from 1.x to the Current Version

If you are currently running TechSmith Relay (formerly Camtasia Relay) version 1.0 and want
to upgrade to themost current version of TechSmith Relay, it is important to know that this is a
two step upgrade. There is NOT a direct upgrade option from version 1 to the current version of
TechSmith Relay.

Before you start, you will need one of the available TechSmith Relay installers:

Relay_Server_Setup_2.0_x64.exe

Use this installer for upgrading TechSmith Relay on a 64-bit server operating system.

If you need assistance locating these installers, see the TechSmith Support Center:
https://support.techsmith.com/hc/en-us.

Upgrade from 1.0 to the Current Version
1. Upgrade the TechSmith Relay (formerly Camtasia Relay) server to version 2.0 by running the 2.0

installer. Follow the instructions in the installer to complete the upgrade.
2. If it is not already installed, you are prompted to install . NET Framework 3.5 with Service Pack 1. This

is likely to be the longest part of the installation.

The installation of .NET Framework 3.5 with Service Pack 1 requires a server reboot,
so tominimize downtime for the TechSmith Relay server, youmay wish to schedule
the upgrade during off-peak hours.

After the .NET Framework has been installed, the TechSmith Relay server upgrade continues.

3. The installer prompts for the password for the “RelayAdmin” user which is used as the default admin
account for the TechSmith Relay website. If using the Express setup installation path, this password
is also used as the password for the “Relay” SQL user for the database.

4. Continue with Upgrade from 2.0 and Later to the Current Version.

Considerations

All server settings are preserved during the upgrade.

All user information is preserved.

All profiles and publish settings are preserved, but some concepts changed with version 2.0. Please
log into the TechSmith Relay website as an administrator and review the online help.
Job information (i.e. presentations) ARE NOT preserved.

https://support.techsmith.com/hc/en-us
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1.0.x recorders do not work with a current server.
Presenters running on theWindows operating system are able to record and submit present-
ations, but they cannot upload to the server. The recorder appears offline and run as not con-
nected to the server. Once presenters install the new version, any submitted presentations will
then upload to the server.
Presenters running onMac operating systems receive amessage to download a new recorder,
but there is a known bug that crashes the recorder when you click the button to download the
upgrade. These presenters need to download and install themost recent recorder to do any fur-
ther recording.

When the user installs a current recorder and has jobs from version 1.0 pending on their computer, the
1.0 jobs are converted to current version jobs and submitted automatically. The titles and descriptions
are preserved, but the user and profile ARE NOT preserved. The presentation is uploaded to the server
using the Upload and Decide Later profile with a guest user that has the original presenter’s email
address. This allows the administrator to push through or delete the jobs, and it also allows the
presenters to log in and see their old jobs.

A result of this is that jobs in a pending state (Needs Attention or Error) before upgrade are uploaded
again. Depending on the server settings, the presenter and administrator may get an email saying a
guest has uploaded a presentation on the presenter’s behalf.

All installations of TechSmith Relay (formerly Camtasia Relay) 1.0, 1.1, and 1.2 used the same encryp-
tion key. If you installed 2.0 as an upgrade to versions 1.0, 1.1, or 1.2 then your server/team uses this
same key.

For security reasons, youmay wish to change your server/team to use a random encryption key. You
can accomplish this using the TechSmith Relay Configuration Protection Tool. You can find the instruc-
tions for using this tool in the TechSmith Relay Server Security Administrator Guide, found on the
TechSmith website: http://www.techsmith.com/tutorial-techsmith-relay-self-hosted-current.html.

http://www.techsmith.com/tutorial-techsmith-relay-self-hosted-current.html
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Upgrade from 2.0 and Later to the Cur-
rent Version
All server settings, users, profiles, publish settings, and presentations are preserved during an upgrade.

We recommend that you backup your current database before starting any upgrade.

1. Log in to the TechSmith Relay website as an administrator.

2. Go to System > Servers.

3. Select each server and click Take Server Offline. This lets the servers continue to process all existing
presentations but not accept any additional presentations.

4. When all encoding and publishing jobs havemoved to Completed, click Shutdown.

Any presentations that are not completed are canceled. After Relay is upgraded and the
server brought back online, all canceled jobs are automatically retried.

5. Run the installer and follow the instructions in the installer to complete the upgrade.

6. When the upgrade is complete, repeat the upgrade on all teamed servers. The upgrade process auto-
matically restarts the servers.

Youmust upgrade all teamed servers to the same version.

While upgrading a server team, if you fail to upgrade a server in the team, it is possible to bring
the server still running the older version online. If this happens, this server connects to the old
version database and appears to be working correctly but it cannot interact with the upgraded
current servers.
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Upgrade Recorders
Following the upgrade of the server, you can notify the presenters that a new version of the TechSmith Relay
recorder is available. Presenters are also notified through the recorder that there is a new version available for
download and installation.

The recorder is available from the homepage after a presenter logs into the TechSmith Relay server.

To deploy the recorder in aWindows enterprise environment, theMSI file can be used. Log in to your
TechSmith Relay website as an administrator and open the help for more information.

Presenters should close the TechSmith Relay recorder if it is open and then run the new recorder installer. The
previous recorder is uninstalled and the new version is installed. They do not lose any saved recordings and
any submitted recordings will upload after the upgrade.

For recorder clients downloaded from a 4.1.0 or later server, an upgrade notification is dis-
played in the toolbar of the recorder when a new version of the TechSmith Relay recorder is
available.

Server Certificate Errors
By default, TechSmith Relay recorders fail to connect to a TechSmith Relay Server with an invalid
server certificate.

If your organization is using a self-signed server certificate on the TechSmith Relay server, then you have the
following options to allow recorders to connect to the server:

Add the self-signed server certificate to client’s trusted certificate stores

If self-signed server certificate is added to a client’s trusted certificate store, users on that client
machine should be able to use a web browser to connect to the TechSmith Relay server website
without having to click through a server certificate warning.
Modify the recorder’s configuration to ignore all server certificate errors

By default, the configuration option to Ignore Server Certificate Errors is not enabled.

If you need to allow TechSmith Relay recorders to connect to a server with an invalid server cer-
tificate, youmust enable this option. When enabled, recorders ignore all server (SSL) certificate
errors when connecting to the TechSmith Relay server.
When you change this option, TechSmith Relay's Manager Servicemust be restarted on all
teamed servers for it to take effect. Any recorders installed before changing this optionmust be
updated or they will fail to connect to the TechSmith Relay server.
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Migrate TechSmith Relay to a New Server
The following procedures cover the three different scenarios for migration of TechSmith Relay components to
a new server:

Migrate the TechSmith Relay Application and Database to a New Server

Migrate Only the TechSmith Relay Database to a New Server

Migrate Only the TechSmith Relay Application to a New Server

Important Information
These procedures are necessary only if you wish tomaintain your TechSmith Relay database inform-
ationmoving forward. The database includes information such as users, profiles, publishing des-
tinations, and historical presentation information.

If you do not wish tomaintain this data and would rather start with a fresh installation on the new
server, first deactivate your current server and then follow the process in the TechSmith Relay Install-
ation Guide, which is available in the TechSmith Relay tutorials section: http://www.tech-
smith.com/tutorial-techsmith-relay-self-hosted-current.html

These procedures require taking your TechSmith Relay server offline and then into a shutdownmode.
It is recommended that you read through the whole procedure prior to actual migration. You should
familiarize yourself with the procedures and understand how the proceduremay impact presentation
processing for TechSmith Relay presenters.
Prior to using the procedures in this document, the following prerequisites must bemet:

TechSmith Relay 2.0 (known as Camtasia Relay 2.0) or above installed on the current server.

If the version of Camtasia Relay is lower than 2.0, see Upgrade from 1.x to the Current Version
for more information.

SQL Server Management Studio installed on amachine that can access the databases of both
the current SQL server and the new server.
SQL Server installed with an instance called Relay installed on both servers.

It is recommended that you install SQL Server 2014 R2 Express Edition of SQL Server. To
download the installer, go to http://www.microsoft.com/sqlserver/2008/en/us/express.aspx.

If you have upgraded TechSmith Relay on your current server, youmay havemultiple databases, with
different names, in your Relay SQL instance. Make sure you choose themost recent TechSmith Relay
database. The names for the TechSmith Relay databases are:

TechSmith Relay Version Database Name

2.0 Relay20

http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.microsoft.com/sqlserver/2008/en/us/express.aspx
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TechSmith Relay Version Database Name

3.0.0 Relay300

3.0.1 Relay301

3.0.2 Relay302

3.0.3 Relay303

3.1.0 Relay310

4.0.0 Relay400

4.0.1 Relay401

4.0.2 Relay402

4.0.3 Relay403

4.1.0 Relay410

4.1.1 Relay411

4.1.2 Relay412

4.2.0 Relay420

4.2.1 Relay421

4.3.0 Relay430

4.4.0 Relay440

5.0.1 Relay501

Migrate the TechSmith Relay Application and
Database to a New Server

1. Log in to the TechSmith Relay website as an administrator on the source (current) server.
2. Go to System > Servers. Click Take Server Offline.

The server continues to process all existing presentations but does not accept any additional present-
ations.

3. When all encoding and publishing jobs havemoved to Completed, click Shutdown.
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Any presentations that are not completed are canceled. (After the database is moved and the
TechSmith Relay server is brought back online, all canceled jobs are automatically restarted.)

4. Go to System > Activation.
5. Click Deactivate.
6. Please back up the TechSmith Relay database using instructions found in Back Up the Database.
7. Copy the database backup file to the target server.
8. Using the same path and name of themedia directory on the source server, create amedia directory on

the target server.

Themedia directory location was set during the initial installation of TechSmith Relay.

The location of themedia directory on the target server must be exactly the same as the
source server. To find this information, open a web browser and go to https://
(RelayWebsiteName)/Relay/relayconfig.aspx. The path is located in the
MediaDirectory row.

9. Copy the contents of themedia directory from the source server to the target server.
10. On the source server, navigate to [install directory]/Utilities and open the Con-

figuration Protection Tool (ConfigurationProtectionTool.exe).
11. Click Load Current Server Settings.

Later in this procedure, you will need the SQL username and password for TechSmith
Relay. If you do not already have this information, click the SQLConnection tab. The
username and password are listed.

12. Go to the Import/Export tab.
13. Click Export Settings to File to export the server encryption settings.
14. Move the resulting XML file to the target server.
15. If you want currently installed TechSmith Relay recorders to be able to connect to the target server, the

server must keep the same endpoint (often the Fully Qualified Domain Name) as the source server. If
the endpoint is not kept the same, presenters must download and install new recorders from the target
server in order to connect.

To keep the same endpoint on the target server, perform one of the following procedures:

If the TechSmith Relay recorders address the server by host name only (e.g.
https://relay):

Rename your source server to free the computer name. For information on how to do
this, see http://support.microsoft.com/kb/295017.
Reboot the source server.

Change the target server to the original name of the source server.

Reboot the target server.

If the TechSmith Relay recorders address the server by the fully-qualified domain name (e.g.
https://relay.university.edu) and the server name is different than the DNS host

http://support.microsoft.com/kb/295017
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name:
Name the target server as desired.

Modify the DNS record for the TechSmith Relay endpoint to point to the IP address of
the target server.

If the TechSmith Relay recorders address the server by the fully-qualified domain name (e.g.
https://relay.university.edu) and the server namematches the DNS host name:

Confirm that the TechSmith Relay endpoint DNS name is the result of dynamic DNS
registration. Your Active Directory or DNS administrator should be able to provide this
information.
Rename your source server to free the computer name. For information on how to do
this, see http://support.microsoft.com/kb/295017.
Reboot the source server.

Change the target server to the original name of the source server.

Reboot the target server.

Verify that the DNS record for the Relay endpoint reflects the IP address of the target
server.

16. Restore the database on the target server using the instructions found in Restore the Camtasia Relay
Database.

17. In the Object Explorer pane of SQL Server Management Studio, go to Relay Database Instance >
Security > Logins.

18. Right-click Logins and select New Login.

The following assumes that Relay is used as the database user. If you chose to use a
different database user during initial installation of TechSmith Relay, substitute that
user name for the user named Relay in the following process.

19. Enter Relay (or your selected database user) for the Login name.
20. Enable the SQL Server authentication option and enter the same password used on the source server.

(See tip in step 11.)
21. Disable the User must change password at next login option.
22. Right-click Logins and select New Login.
23. Enter RelayCache (use RelayCache even if you selected a different name for the database user)

for the Login name.
24. Enable the SQL Server authentication option and enter the same password used on the source server.
25. Disable the User must change password at next login option.
26. Replacing RelayDbName with your TechSmith Relay database name, run the following query against

the Relay instance on the target SQL server:

The following SQL statement assumes that Relay is used as the database user. If
you chose to use a different database user during initial installation of TechSmith
Relay, substitute that user name for the user named Relay in the following process.

http://support.microsoft.com/kb/295017
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USE RelayDbName

ALTER USER Relay WITH LOGIN = Relay

ALTER USER RelayCache WITH LOGIN = RelayCache

USE master

ALTER DATABASE RelayDbName SET SINGLE_USER WITH ROLLBACK

IMMEDIATE

ALTER DATABASE RelayDbName SET ENABLE_BROKER

ALTER DATABASE RelayDbName SET MULTI_USER

27. Run the TechSmith Relay installer on the target server, making sure to:

Select Keep your existing database.

Set themedia directory the same as what it was on the source server.

Use the sameRelay SQL user password as on the source server’s database.

The TechSmith Relay website andmanager service will not be able to access the database
unless the Relay SQL password on the target server is the same password that was used on
the source server's database.

28. Go to [install directory]/Utilities and open the Configuration Protection Tool (Con-
figurationProtectionTool.exe).

29. Go to the Import/Export tab.
30. Click Browse, locate the XML file that you created on the source server, and then click Open.
31. Click the SQLConnection tab. Change the Data Source to the instance name (e.g. yours-

ervername\Relay) on the target server.
32. Go to the Encryption tab.
33. Click Install New Key.
34. Log in to the server website as an administrator.
35. Go to System > Activation and enter your license key.
36. You can now uninstall TechSmith Relay from the source server.
37. If the target server was not updated to have the same endpoint as the source server (step 15), there is

still an entry for the source server’s endpoint in the database. Contact TechSmith Technical Support
(http://support.techsmith.com) for assistance removing the source endpoint.

Migrate Only the TechSmith Relay Database
to a New Server

1. Log in to the TechSmith Relay website as an administrator on the source (current) server.
2. Go to System > Servers. Click Take Server Offline.

http://support.techsmith.com/
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The server continues to process all existing presentations but will not accept any additional present-
ations.

3. When all encoding and publishing jobs havemoved to Completed, click Shutdown.

Any presentations that are not completed are canceled. (After the database is moved and the
TechSmith Relay server is brought back online, all canceled jobs are automatically restarted.)

4. Please back up the TechSmith Relay database using instructions found in Back Up the Database.
5. Copy the database backup file to the target (new) server.
6. Restore the database on the target server using the instructions found in Restore the Camtasia Relay

Database.
7. In the Object Explorer pane of SQL Server Management Studio, go to Relay Database Instance >

Security > Logins.
8. Right-click Logins and select New Login.

The following assumes that Relay is used as the database user. If you chose to use a
different database user during initial installation of TechSmith Relay, substitute that
user name for the user named Relay in the following process.

9. Enter Relay (or your selected database user) for the Login name.
10. Enable the SQL Server authentication option and enter the same password used on the source server.
11. Disable the User must change password at next login option.
12. Right-click Logins and select New Login.
13. Enter RelayCache (use RelayCache even if you selected a different name for the database user)

for the Login name.
14. Enable the SQL Server authentication option and enter the same password used on the source server.
15. Disable the User must change password at next login option.
16. Replacing RelayDbName with your TechSmith Relay database name, run the following query against

the Relay instance on the target SQL server:

The following SQL statement assumes that Relay is used as the database user. If
you chose to use a different database user during initial installation of TechSmith
Relay, substitute that user name for the user named Relay in the following process.

USE RelayDbName

ALTER USER Relay WITH LOGIN = Relay

ALTER USER RelayCache WITH LOGIN = RelayCache

USE master

ALTER DATABASE RelayDbName SET SINGLE_USER WITH ROLLBACK

IMMEDIATE

ALTER DATABASE RelayDbName SET ENABLE_BROKER
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ALTER DATABASE RelayDbName SET MULTI_USER

17. Uninstall the TechSmith Relay server software on the server. This allows a reinstall while pointing to a
different database server.

18. Run the TechSmith Relay installer on the server, making sure to:
Select the Advanced installation option.

When prompted for a SQL Server Connection, specify the target database server name (Tar-
getServerName\Relay) as the SQL Server name.
Select Keep your existing database.

Set themedia directory to the same directory that it was before the uninstall.

Use the sameRelay SQL user password as on the source server’s database.

The TechSmith Relay website andmanager service will not be able to access the database
unless the Relay SQL password on the target server is the same password that was used on
the source server's database.

19. Log in to the server website as an administrator.

Migrate Only the TechSmith Relay Application
to a New Server
It is recommended that you let all existing presentations finish processing before performing themigration. To
do this youmust first take the server offline, which prevents it from further accepting presentation uploads,
and then lets it process those presentations. Instructions for performing those functions are listed below.

1. Log in to the TechSmith Relay website as an administrator on the source (current) server.
2. Go to System > Servers. Click Take Server Offline.

The server continues to process all existing presentations but will not accept any additional present-
ations.

3. When all encoding and publishing jobs havemoved to Completed, click Shutdown.

Any presentations that are not completed are canceled. (After the database is moved and the
TechSmith Relay server is brought back online, all canceled jobs are automatically restarted.)

4. Go to System > Activation.
5. Click Deactivate.
6. Using the same path and name of themedia directory on the source server, create amedia directory on

the target server.

Themedia directory location was set during the initial installation of TechSmith Relay.

The location of themedia directory on the target server must be exactly the same as the
source server. To find this information, go to yours-
ervername/Relay/relayconfig.aspx. The path is located in theMediaDirectory
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row.

7. Copy the contents of themedia directory from the source server to the target server.
8. On the source server, navigate to [install directory]/Manager and open the Configuration

Protection Tool (ConfigurationProtectionTool.exe).
9. Click Load Current Server Setting.
10. Go to the Import/Export tab.
11. Click Export Settings to File to export the server encryption settings.
12. Move the resulting XML file to the target server.
13. If you want currently installed TechSmith Relay recorders to be able to connect to the target server, the

server must keep the same endpoint (often the Fully Qualified Domain Name) as the source server. If
the endpoint is not kept the same, presenters must download and install new recorders from the target
server in order to connect.

To keep the same endpoint on the target server, perform one of the following procedures:

If the TechSmith Relay recorders address the server by host name only (e.g.
https://relay):

Rename your source server to free the computer name. For information on how to do
this, see http://support.microsoft.com/kb/295017.
Reboot the source server.

Change the target server to the original name of the source server.

Reboot the target server.

If the TechSmith Relay recorders address the server by the fully-qualified domain name (e.g.
https://relay.university.edu) and the server name is different than the DNS host
name:

Name the target server as desired.

Modify the DNS record for the TechSmith Relay endpoint to point to the IP address of
the target server.

If the TechSmith Relay recorders address the server by the fully-qualified domain name (e.g.
https://relay.university.edu) and the server namematches the DNS host name:

Confirm that the TechSmith Relay endpoint DNS name is the result of dynamic DNS
registration. Your Active Directory or DNS administrator should be able to provide this
information.
Rename your source server to free the computer name. For information on how to do
this, see http://support.microsoft.com/kb/295017.
Reboot the source server.

Change the target server to the original name of the source server.

Reboot the target server.

http://support.microsoft.com/kb/295017
http://support.microsoft.com/kb/295017
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Verify that the DNS record for the TechSmith Relay endpoint reflects the IP address of
the target server.

14. Run the TechSmith Relay installer on the target server, making sure to:

Change the SQL Server name listed to the database server of your installation when prompted
for a SQL Server Connection.

Select Keep your existing database.

Set themedia directory the same as what it was on the source server.

Use the sameRelay SQL user password as on the source server’s database.

The TechSmith Relay website andmanager service will not be able to access the database
unless the Relay SQL password on the target server is the same password that was used on
the source server's database.

15. Go to [install directory]/Manager and launch the Configuration Protection Tool.
16. Go to the Import/Export tab.
17. Click Browse, locate the XML file that you created on the source server, and click Open.
18. Go to the SQLConnection tab. Change the Data Source to the instance name (e.g. yours-

ervername\Relay) on the target server.
19. Go to the Encryption tab.
20. Click Install New Key.
21. Log in to the server website as an administrator.
22. Go to System > Activation and enter your license key.
23. You can now uninstall TechSmith Relay from the source server.
24. If the target server was not updated to have the same endpoint as the source server (step 15), there is

still an entry for the source server’s endpoint in the database. Contact TechSmith Technical Support
(http://support.techsmith.com) for assistance removing the source endpoint.

Back Up the Database
The following procedure covers how to back up the TechSmith Relay database using SQL Server Man-
agement Studio. For additional information and other ways to perform a backup, see the following:

TechSmith Relay Technical ReferenceGuide (available in the TechSmith Relay Tutorials section:
http://www.techsmith.com/tutorial-techsmith-relay-self-hosted-current.html)
How to: Back Up a Database (SQL Server Management Studio): https://msdn.microsoft.com/en-us/lib-
rary/ms187510(v=sql.110).aspx

This procedure can be performed locally on the database server or from a remotemanagement workstation
with SQL Server Management Studio installed if remote access to the database server has been allowed.
However, disk locations denoted in the backup procedure will always be local to the database server.

http://support.techsmith.com/
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://msdn.microsoft.com/en-us/library/ms187510(v=SQL.105).aspx
http://msdn.microsoft.com/en-us/library/ms187510(v=SQL.105).aspx
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1. Right-click the database to back up and select Tasks > Back Up.

2. On theGeneral tab, select backup type Full and set a location on disk for the backup file.
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3. Choose to back up to an existing backup set or to append to a new backup set. Selecting Verify
backup when completed is recommended. Then, click OK.

The backup is complete.

Restore the Camtasia Relay Database
The following procedure covers how to restore the TechSmith Relay database using SQL Server Management
Studio. For additional information and other ways to perform a backup, see the following:

TechSmith Relay Technical ReferenceGuide (available on TechSmith.com: http://www.tech-
smith.com/tutorial-techsmith-relay-self-hosted-current.html)

http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
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How to: Restore a Database Backup (SQL Server Management Studio): http://msdn.-
microsoft.com/en-us/library/ms177429.aspx

To restore a database backup file using SQL Server Management Studio:

1. Place the backup file in a folder on the database server that can be locally accessed by SQL Server.
2. Open SQL Server Management Studio.
3. Right-click the existing database or Databases (if restoring to a new database) and select Tasks >

Restore > Database.

4. Set the database name to restore. Select From Device and click … to select the backup file.

http://msdn.microsoft.com/en-us/library/ms177429.aspx
http://msdn.microsoft.com/en-us/library/ms177429.aspx
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5. Click Add to select the location of your database backup file. Click OK.
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6. Set Restore options to overwrite the database (if applicable), restore files to correct path, and Leave
the database ready to use. Click OK.
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The database is now restored.
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What's New in 5.0.1
The following is a summary of the new features and updates in TechSmith Relay 5.0.1.

Youmay want to review the current known issues for TechSmith Relay 5.0.1. You can find the
list of known issues in the TechSmith Support Center.

TechSmith Relay 5.0.1 (Self-Hosted) introduces some great new features that enhance your user experience,
make your workflows simpler, andmakemanagement of your users more robust than ever. Along with the
new features, we will bemoving the self-hosted product to a subscription-basedmodel, whichmeans easier
management of your software licensing, more rapid release of new features, and continuedmaintenance
along with our world-class technical support.

New Features
Upload existing content, includingmultiple files at once, through the TechSmith Relay Recorder applic-
ation.
Support for images captured in Snagit, from your mobile device with TechSmith Fuse, or uploaded
using the TechSmith Relay Recorder.
Support for Knowmia Teach Pro by TechSmith, allowing you to create and share from your iPad.

Server Requirement Changes
TechSmith Relay has been engineered to process files faster than ever. Because of this, we have increased
our minimum system requirements for the Server component: 1, 3, and 7 encoding instances have been
replaced by Small and Large instances. In order for TechSmith Relay to function, you will need aWindows
Server with at least 4 cores.

Dropped support for Internet Explorer 8 and 9 for the TechSmith Relay Web Application.

Performance Improvements and Bug Fixes
Improved LDAP integration for better user management.

Fixed a bug causing some quizzes created in Camtasia Studio to publish, but not report results.

Fixed a bug where videos weren’t shrinking to fit a smaller browser window.

Fixed a bug causing some presenter accounts to be left without titles, and /or prevented those account
holders from publishing.
Fixed a bug limiting functionality of speech-to-text inWindows Server 2012 R2.

Fixed…many moreminor bugs!

https://support.techsmith.com/hc/en-us
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Help and Support Resources
There are several different ways to get help for using TechSmith Relay.

TechSmith Relay Website and Recorder Help
For day-to-day administration of Camtasia Relay, please see the Camtasia Relay Website
Help. This help is available after logging into the Camtasia Relay website as an administrator.
Just click a Help link, available on each web page, to open the TechSmith Relay Administrator
Help.

For help with the TechSmith Relay Recorder, please install and open the recorder or open the
portable recorder to access presenter help.

TechSmith Relay Tutorials

In the TechSmith Relay section of the TechSmith.com tutorials, you can find themost up-to-date tutori-
als and product documentation.

The following PDF documents are available for download:

TechSmith Relay Installation Guide

Learn how to install the TechSmith Relay server.

TechSmith Relay Upgrade Guide

Learn how to upgrade TechSmith Relay.

TechSmith Relay Administrator Website Help

Walk through configuration and administration information to help you keep TechSmith Relay
running smoothly.

TechSmith Relay Presenter Website Help

Help presenters understand how to interact with the website and server

TechSmith Relay Recorder Help (Windows and Mac)

PDF versions of the recorder help for presenters.

TechSmith Support Center

The TechSmith Relay Tech Support team is ready and waiting for your questions. Should you have
problems that you cannot solve using the resources provided, please contact us wewill be happy to
assist.

Search the Knowledge Base on the Support Center page: http://support.techsmith.com. It is
possible that the issue is a known issue and there is already an answer available.
Submit a question to Technical Support. Click Ask aQuestion on the Support Center page.

Call Technical Support

http://www.techsmith.dev/tutorial-techsmith-relay-self-hosted-current.html
http://support.techsmith.com/
http://support.techsmith.com/
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Phone: +1.517.381.2300 (ext. 784)
Toll Free in the U.S. & Canada: 800.517.3001 (ext. 784)
Tech Support Website: http://support.techsmith.com

Feedback

If you would like to offer feedback on or suggestions of topics to cover in this or any other TechSmith
Relay documentation, please send an email to relayhelp@techsmith.com.

http://support.techsmith.com/
mailto:relayhelp@techsmith.com
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TechSmith Relay and Camtasia Studio
Harness the editing power of Camtasia Studio in TechSmith Relay!

Edit TechSmith Relay videos in Camtasia Studio, and then send back to TechSmith Relay for distribution.
They play nicely together so your content flows seamlessly from one application to another.

There are several ways to use Camtasia Studio with TechSmith Relay, depending on what you are trying to
do. Find which option will work best for you:

Automatically ProduceMultiple Formats and Destinations

Full Editing Capability with Ease of TechSmith Relay Recording

Record with TechSmith Relay, Edit with Camtasia Studio, Publish with TechSmith Relay

The procedures that follow assume that you are already familiar with Camtasia Studio and
TechSmith Relay. To learn about Camtasia Studio or TechSmith Relay, please refer to the in-
product help or the TechSmith tutorials.

The Basics
The TechSmith Relay Recorder must be installed on the same computer as Camtasia Studio in order
for the TechSmith Relay production preset to appear in the Camtasia Studio ProductionWizard.
TechSmith Relay profile settings take precedence over Camtasia Studio presets. When processing
and publishing presentations with TechSmith Relay, the final formats and publish locations are dic-
tated by profile settings.
The CAMPROJ project file used in Camtasia Studio is rendered to AVI before it uploads to TechSmith
Relay for processing; some features available when working in Camtasia Studio are disregarded when
producing through TechSmith Relay because they are not compatible with the AVI file type.

Automatically Produce Multiple Formats and
Destinations
Summary

1. Record: Camtasia Studio
2. Edit: Camtasia Studio
3. Produce: TechSmith Relay

When to Use

You are familiar with Camtasia Studio and its recording and editing fea-
tures.
You would like to use TechSmith Relay to efficiently publish a variety of
video formats and/or to multiple locations.
You are familiar with Camtasia Studio and your workplace requires all
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videos to be published to locations under the control of a network admin-
istrator (via a TechSmith Relay profile).

Advantages

Ability to use SmartFocus and other Camtasia recording effects (not
available in TechSmith Relay recordings).
Recording file (CAMREC) is saved locally and ready for immediate edit-
ing in Camtasia Studio.
TechSmith Relay production saves the person editing from having to
make processing and publishing decisions.
TechSmith Relay production saves time if you want multiple video
formats and automated publishing tomultiple destinations.

Considerations

When recording, select Full Screen as the recording dimensions.

In Camtasia Studio, choose dimensions that match your largest
TechSmith Relay profile. If you are uncertain, select Recording Dimen-
sions as the preset (in Editing Dimensions). Later, TechSmith Relay will
use your profile to determine final dimensions and formats.
Cannot use Flash hotspots, quizzes, survey, end actions (lose when
converted to AVI).
Closed captions are available when producing with TechSmith Relay
only when the selected profile supports captions (MP4with Smart
Player encode settings).
Camtasia Studio first produces an AVI file and then sends it to
TechSmith Relay, where it is processed and published as dictated in the
selected profile.

How To
1. Open Camtasia Studio. In theWelcome dialog box, click Record the screen.
2. Click Full Screen in the Camtasia Recorder.
3. Click theRecord button.
4. Give your presentation. When finished, click Stop.
5. In the Preview window, click Save and Edit.
6. Select Original recording dimensions in the Editing Dimensions dropdown list and click OK.
7. Edit the presentation with Camtasia Studio.

Note: Do not add Flash hotspots, quizzes, surveys, or end actions; these items are not supported.

8. From the Produce and share dropdown list, select Share to TechSmith Relay.
9. Log in with a TechSmith Relay presenter username and password.
10. Select a profile. Enter a title and description. Click Submit.

See the TechSmith Relay Recorder help for more information about what happens after a presentation is sub-
mitted.
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Full Editing Capability with TechSmith Relay
Recording
Summary

1. Record: TechSmith Relay
2. Edit: Camtasia Studio
3. Produce: Camtasia Studio

When to Use

Multiple presenters record and one or more experienced Camtasia Stu-
dio users do the editing and production.
Since the presenters just record, submit the presentation, and walk
away, this option works great for conferences or quality control.
This workflow can come in handy when presenting on a computer that
does not have Camtasia Studio, but you want to edit and produce with
Camtasia Studio.

Advantages

Presenters use the simple TechSmith Relay Recorder and others can
edit with Camtasia Studio.
Can record on bothMac andWindows operating systems and then edit
and produce the presentation on a computer running on aWindows oper-
ating system.
Full editing capabilities of Camtasia Studio.

Considerations

Cannot use SmartFocus, ScreenDraw, or other Camtasia Recorder fea-
tures (not available in TechSmith Relay recordings).
Each video format must be produced individually; no automatic pro-
duction and publishing as when using Camtasia Studio for production.
Profile required: A profile that generates a Camtasia Studio recording
(CAMREC) and publishes to a location where the person doing the edit-
ing can retrieve it.

How To
1. Open the TechSmith Relay Recorder.
2. Log in with a presenter username and password.
3. Select a profile. Make sure to choose one that creates a CAMREC.
4. Enter a title and description.
5. Click theRecord button.
6. Give your presentation. When finished, click Stop.
7. Review the presentation and click Submit.
8. When the CAMREC is ready, locate the file and copy it to your computer.
9. Open Camtasia Studio. In theWelcome dialog box, click Import media.
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10. Locate the CAMREC file and click Open.
11. Drag the capture to the timeline and select Recording Dimensions in the Editing Dimensions dropdown

list and click OK.
12. Edit and produce the presentation with Camtasia Studio.

See the Camtasia Studio help or the Camtasia Studio tutorials for information about editing and producing.

Record with TechSmith Relay, Edit with
Camtasia Studio, Publish with TechSmith
Relay
Summary

1. Record: TechSmith Relay
2. Edit: Camtasia Studio
3. Produce: TechSmith Relay

When to Use

The ease of the recording and publishing with TechSmith Relay is
needed, but there is also a need for editing beyond just trimming the
beginning and ending of the presentation.
A designated editor receives a CAMREC of the presentation and pub-
lishes back to TechSmith Relay because there is a need for multiple
formats and/or publish destinations.
A presentation recorded with TechSmith Relay unexpectedly needs a
more involved edit than available with TechSmith Relay.

Advantages

Presenters use the simple TechSmith Relay Recorder.

Presentations are processed and published automatically based on the
selected profile.
Video can undergo advanced editing and still be efficiently produced in
numerous formats and locations.

Considerations

When recording, select Full Screen as the recording dimensions.

Camera video from TechSmith Relay Recorder is not included in the file
sent to Camtasia Studio.
In Camtasia Studio, choose dimensions that match your largest
TechSmith Relay profile. If you are uncertain, select Original recording
dimensions as the preset (in Editing Dimensions). Later, TechSmith
Relay will use your profile to determine final dimensions and formats.
Cannot use Flash hotspots, quizzes, survey, end actions (lost when con-
verted to AVI).
Cannot use SmartFocus (not available when recording with TechSmith
Relay).
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Camtasia Studio first produces a n AVI file and then sends it to
TechSmith Relay, where it is processed and published as dictated in the
selected profile.
Profiles required: One profile that generates a Camtasia Studio record-
ing (CAMREC) and publishes to a location where the person doing the
editing can retrieve it; a second profile to designate the formats and pub-
lishing destinations for the final presentations.

How To
1. Open the TechSmith Relay Recorder.
2. Log in with a presenter username and password.
3. Select a profile that creates a CAMREC.
4. Enter a title and description.
5. Click theRecord button.
6. Give your presentation. When finished, click Stop.
7. Review the presentation and click Submit.
8. When the CAMREC is ready, locate the file and copy it to your computer.
9. Open Camtasia Studio. In theWelcome dialog box, click Import media.
10. Locate the CAMREC file and click Open.
11. Drag the capture to the timeline and select Recording Dimensions in the Dimensions dropdown list and

click OK.
12. Edit and produce the presentation with Camtasia Studio.

Note: Do not add Flash hotspots, quizzes, surveys, or end actions; these items are not supported.

See the Camtasia Studio help or Camtasia Studio Tutorials for information about editing with Camtasia
Studio.

13. From the Produce and share dropdown list, select Share to TechSmith Relay.
14. Log in with a TechSmith Relay presenter username and password.
15. Select a profile. Enter a title and description. Click Submit.

See the TechSmith Relay Recorder help for more information about what happens after a presentation is sub-
mitted.
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TechSmith Relay and Camtasia for Mac
Harness the editing power of Camtasia for Mac in TechSmith Relay.

Edit TechSmith Relay videos in Camtasia for Mac, and then send back to TechSmith Relay for distribution.
They play nicely together so your content flows seamlessly from one application to another.

There are several ways to use Camtasia for Mac with TechSmith Relay, depending on what you are trying to
do. Find which option will work best for you:

Automatically ProduceMultiple Formats and Destinations

Full Editing Capability with Ease of TechSmith Relay Recording

Record with TechSmith Relay, Edit with Camtasia for Mac, Publish with TechSmith Relay

Note: The procedures that follow assume that you are already familiar with Camtasia for Mac and TechSmith
Relay. To learn about Camtasia for Mac or TechSmith Relay, please refer to the in-product help or the
TechSmith Tutorials.

The Basics
The TechSmith Relay Recorder must be installed on the same computer as Camtasia for Mac in order
for the Share to TechSmith Relay option to appear.
TechSmith Relay profile settings take precedence over Camtasia for Mac production options. When
processing and publishing presentations with TechSmith Relay, the final formats and publish locations
are dictated by profile settings.
Some features available when working in Camtasia for Mac are disregarded when producing through
TechSmith Relay. Only markers and closed captions are passed through and only when the selected
profile supports these options (MP4with Smart Player encoding type).

Automatically Produce Multiple Formats and
Destinations
Summary

1. Record: Camtasia for Mac
2. Edit: Camtasia for Mac
3. Produce: TechSmith Relay

When to Use

You are familiar with Camtasia for Mac and its recording and editing fea-
tures.
You would like to use TechSmith Relay to efficiently publish a variety of
video formats and/or to multiple locations.
You are familiar with Camtasia for Mac and your workplace requires all
videos to be published to locations under the control of a network admin-
istrator (via a TechSmith Relay profile).
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Advantages

Recording file (CMREC) is saved locally and ready for immediate editing
in Camtasia for Mac.
TechSmith Relay production saves the person editing from having to
make processing and publishing decisions.
TechSmith Relay production saves time if you want multiple video
formats and automated publishing tomultiple destinations.

Considerations

When recording, select Full Screen as the recording dimensions.

Camera video recorded in TechSmith Relay Recorder is not included
with the file sent to Camtasia for Mac.
In Camtasia for Mac, choose canvas dimensions that match your
largest TechSmith Relay profile. If you are uncertain, select the same
dimensions that were used during recording. Later, TechSmith Relay will
use your profile to determine final dimensions and formats.
Closed captions andmarkers are available when producing with
TechSmith Relay only when the selected profile supports captions
(Flash and Silverlight encoding types only).
Camtasia for Mac first produces a video file and then sends it to
TechSmith Relay, where it is processed and published as dictated in the
selected profile.

How To
1. Open Camtasia for Mac.
2. Select to record the Full Screen.
3. Click theRecord button.
4. Give your presentation. When finished, click Stop.
5. Camtasia for Mac adds the recording file to theMedia Bin and on the timeline.
6. Edit the presentation with Camtasia for Mac.
7. Select the option to share to TechSmith Relay.
8. Log in with a TechSmith Relay presenter username and password.
9. Select a profile. Enter a title and description. Click Share.

See the TechSmith Relay Recorder help for more information about what happens after a presentation is sub-
mitted.

Full Editing Capability with TechSmith Relay
Recording
Summary

1. Record: TechSmith Relay
2. Edit: Camtasia for Mac
3. Produce: Camtasia for Mac
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When to Use

Multiple presenters record and one or more experienced Camtasia for Mac
users do the editing.
Since the presenters just record, submit the presentation, and walk away,
this option works great for conferences or quality control.
This workflow can come in handy when presenting on a computer that
does not have Camtasia for Mac, but you want to edit and produce with
Camtasia for Mac.

Advantages

Presenters use the simple TechSmith Relay Recorder and others can edit
with Camtasia for Mac.
Can record on bothMac andWindows operating systems and then edit
and produce the presentation on a computer running on aMac operating
system.
Full editing capabilities of Camtasia for Mac.

Considerations

Cannot use SmartFocus (not available in TechSmith Relay recordings).

Camera video recorded in TechSmith Relay Recorder is not included with
the file sent to Camtasia for Mac.
Each video format must be shared individually; no automatic production
and publishing as when using Camtasia for Mac for production.
Profile required: A profile that generates a Camtasia for Mac recording and
publishes to a location where the person doing the editing can retrieve it.

TechSmith Relay produces a ZIP file for the Camtasia for
Mac recording files. The ZIP file, when opened on aMac,
automatically unzips into a directory.

How To
1. Open the TechSmith Relay Recorder.
2. Log in with a presenter username and password.
3. Select a profile. Make sure to choose one that creates a Camtasia for Mac recording.
4. Enter a title and description.
5. Click theRecord button.
6. Give your presentation. When finished, click Stop.
7. Review the presentation and click Submit.
8. When the Camtasia for Mac recording is ready, locate the file and copy it to your computer.
9. Open the ZIP folder.
10. Double-click to launch the CMPROJ in Camtasia for Mac.
11. Edit and produce the presentation with Camtasia for Mac.

See the Camtasia for Mac help or Camtasia for Mac tutorials for information about editing and producing.
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Record with TechSmith Relay, Edit with
Camtasia for Mac, Publish with TechSmith
Relay
Summary

1. Record: TechSmith Relay
2. Edit: Camtasia for Mac
3. Produce: TechSmith Relay

When to Use

The ease of the recording and publishing with TechSmith Relay is needed,
but there is also a need for editing beyond just trimming the beginning and
ending of the presentation.
A designated editor receives a Camtasia for Mac recording of the present-
ation and publishes back to TechSmith Relay because there is a need for
multiple formats and/or publish destinations.
A presentation recorded with TechSmith Relay unexpectedly needs a
more involved edit than available with TechSmith Relay.

Advantages

Presenters use the simple TechSmith Relay Recorder.

Presentations are processed and published automatically based on the
selected profile.
Video can undergo advanced editing and still be efficiently produced in
numerous formats and locations.

Considerations

When recording, select Full Screen as the recording dimensions.

In Camtasia for Mac, choose editing dimensions that match your largest
TechSmith Relay profile. If you are uncertain, select the same dimensions
that were used during recording. Later, TechSmith Relay will use your pro-
file to determine final dimensions and formats.
Cannot use SmartFocus (not available when recording with TechSmith
Relay).
Closed captions andmarkers are available when producing with
TechSmith Relay only when the selected profile supports captions (MP4
with Smart Player encoding types only).
Camtasia for Mac first produces a video file and then sends it to
TechSmith Relay, where it is processed and published as dictated in the
selected profile.
Profiles required: One profile that generates a Camtasia for Mac recording
and publishes to a location where the person doing the editing can retrieve
it: a second profile to designate the formats and publishing destinations for
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the final presentations.

TechSmith Relay produces a ZIP file for the Camtasia for
Mac recording files. The ZIP file, when opened on aMac,
automatically unzips into a directory.

How To
1. Open the TechSmith Relay Recorder.
2. Log in with a presenter username and password.
3. Select a profile. Make sure to choose one that creates a Camtasia for Mac recording.
4. Enter a title and description.
5. Click theRecord button.
6. Give your presentation. When finished, click Stop.
7. Review the presentation and click Submit.
8. When the Camtasia for Mac recording is ready, locate the file and copy it to your computer.
9. Open the ZIP folder.
10. Double-click to launch the CMPROJ in Camtasia for Mac.
11. Edit the presentation with Camtasia for Mac.

See the Camtasia for Mac help or Camtasia for Mac tutorials for information about how to use
Camtasia for Mac.

12. Select the option to share to TechSmith Relay.
13. Log in with a TechSmith Relay presenter username and password.
14. Select a profile. Enter a title and description. Click Share.

See the TechSmith Relay Recorder help for more information about what happens after a presentation is sub-
mitted.
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